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A

Legal notice



Copyright and trademark information relating to this product release.

Copyright © 2003–2024 RWS Holdings plc. All rights reserved.

This legal notice applies to RWS Holdings plc and its subsidiaries and affiliates. All intellectual
property rights contained herein are the sole and exclusive rights of RWS. All references to
RWS shall mean RWS Holdings plc and its subsidiaries and affiliates details of which can be
obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by RWS. Except as otherwise expressly permitted hereunder
or in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of RWS.

Tridion Docs is a registered trademark of RWS. All other trademarks are the property of
their respective owners. The names of other companies and products mentioned herein may
be the trademarks of their respective owners. Unless stated to the contrary, no association
with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ” on page 79 .

Although RWS takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or
damage of any kind or arising out of, or in connection with, the use or performance of the
Software Documentation even if such losses and/or damages were foreseen, foreseeable or
known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of
business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or
consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." RWS makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of RWS.
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1

Welcome to Content Manager
Upgrade Guide



This document presents a description of all needed checks and actions necessary for an
upgrade from the previous version of Content Manager to the latest version.

Customer support
To contact Technical Support, connect to the Customer Support Web Portal at
https://gateway.sdl.com and log a case for your RWS product. You need an account to log a
case. If you do not have an account, contact your company's RWS Support Account
Administrator.

1 Welcome to Content Manager Upgrade Guide
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2

Upgrading Content Manager



This section explains how to upgrade the Content Manager application, Content
Managerdatabase and Content Manager client tools, and how to enable the other Tridion
Docs capabilities.

When upgrading, note the following:

• These instructions ony describe to an upgrade of the Content Manager application only.
You are assumed to have already upgraded your operating system, database server
and other third-party software, if needed, to meet Content Manager requirements.

• The earliest version from which you can upgrade to the current Content Manager version
is Content Manager 13.0.0. To upgrade from an earlier version, you must first upgrade
to Content Manager 13.0.0 (and perform the post-upgrade operations).

Content Manager requirements
All requirements for the Content Manager application, web, and batch servers are described.

Content Manager hardware requirements
Check the hardware requirements.

Hardware
The performance of Content Manager depends primarily on the CPU power and the I/O
characteristics of the hardware. High CPU power is needed to allow the system to make
calculations on-the-fly, e.g. for publishing. The I/O performance largely influences the
system’s speed to gather and assemble information from the database to serve user
requests. Content Manager imposes no specific requirements for data storage, as it holds
generic versions that become specific versions by calculation on a user's request.

The hardware required for a specific Content Manager implementation depends on the
specific requirements and settings of the project (for example, the number of concurrent
users). The exact definition of the hardware requirements is typically done at the
beginning of the project.

Database
The database server may be on any platform supported by the database vendor. Hardware
and platform requirements for the database server should be obtained from the database
vendor. The specifications supplied by Content Manager should be checked against the
specifications supplied by the database vendor for the current hardware on which it is
installed.

An example Microsoft Windows server machine could minimally have the following
specifications:

• CPU: dual core contemporary CPU

• Internal Memory: 8 GB RAM

Database storage demands must account for the following:

• All XML content and related metadata.

• All images.

• Published output (e.g. PDF, CHM...).

2 Upgrading Content Manager
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As a rule of thumb, multiply the size of all images by 3 to get an estimate of the starting
size for your database. A normal documentation project can use 100 GB for its storage
needs for about 2 to 3 years.

Web and Application layer
The server can be on a single system. However, for performance reasons it is advised to
scale and have redundancy over multiple servers. The scaling introduction included in
Tridion Docs documentation helps you determine the setup. Due to the many setup
variations, you may want to contact the support team to discuss your specifics.

Minimum server configuration: A recent quad core system(s) containing 8 GB of RAM or
more. Virtualized environments are supported if they are guaranteed to behave like a
Windows OS installed on a physical machine. If performance is or becomes an issue, you
are advised to use physical servers.

Storage demands: The consumers of storage are the actual installed Content Manager
software components, the full-text-index collection, exported, and published content.
Considering a normal documentation project, with an initial database reservation of 100
GB, the server should have at least 50 GB storage capacity. The typical setup is two servers,
one handling the synchronous operations and one server handling the asynchronous/
background operations. Initially you can start with one server handling all operations; we
then suggest a dual CPU server. A second server can be added quite easily afterwards if
load needs to be reduced on the primary server.

Client requirements
Client machines running desktop applications such as Publication Manager should have
at least a 2.0 GHz CPU and 4 GB RAM.

Network requirements
Due to its stateless model, Content Manager passes large quantities of data. A 10 Mbit
network connection provides a more than acceptable throughput.

Content Manager software requirements
Information about third-party or client software that is packaged, configured and tested for
this software version release.

The following overview includes information about:

• Third-party software that is configured or integrated in this server-side component
release.

• Third-party software, such as the operating systems, databases, and runtimes that are
quality-assurance tested.

• Client hardware and software compatibility.

The relation between the Authoring Bridge and the XML editors is not specified here.
Installation packages for Authoring Bridge are not always available for all XML editors. Also
third-party software such as authoring tools and databases have their specific requirements.
Check out the third-party tools' documentation before installation.

This is a reference list not a task list. It specifies on which items our software relies. Some
components might already be installed by other software. Some components may be needed
only for certain features or configurations of Content Manager. Refer to the Content

2Upgrading Content Manager
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Manager installation or upgrade tasks to know which of the specified software you need to
install.

Supported software versions

Note: Names, trademarks, designs, logos, service marks, intellectual property and so on,
of the products shown are exclusive property of their respective owners.

Application server
• One of the following:

• Microsoft Windows Server 2022

• Microsoft Windows Server 2019 x64

• Microsoft Windows PowerShell 5.1 (part of Windows Management Framework 5.1)

• Microsoft .NET Framework 4.8

• ASP.NET Core Hosting Bundle, version 8 (includes the Microsoft .NET 8 LTS runtime)

• One of the following:

• Oracle Java Development Kit 21.0.x x64 also known as Oracle JDK 21 LTS

• Adoptium Eclipse Temurin 21.0.x x64 based on OpenJDK 21 LTS

• Oracle Java Development Kit 17.0.x x64 also known as Oracle JDK 17 LTS

• Adoptium Eclipse Temurin 17.0.x x64 based on OpenJDK 17 LTS

• DITA-OT 2.3

Note: Our standard Tridion Docs installation package holds a DITA Open Toolkit version.

• Microsoft XML Parser 6.0, 32-bit and 64-bit (pre-installed with Windows Server 2012R2
and 2016)

• Software for publishing, as required:

• Java Help 2.0.05

• HTML Help Workshop 1.3

• AntennaHouse XSL Formatter 7.0

Database server
One of the following database systems:

• Oracle Database 19c (19.3.0.0)

• Microsoft SQL Server 2022

• Microsoft SQL Server 2019

2 Upgrading Content Manager
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Client
• One of the following operating systems:

• Microsoft Windows 11

• Microsoft Windows 10

• One of the following web browsers:

• Microsoft Edge (Chromium-based; Microsoft's Modern Lifecycle Policy release
update channel)

• Google Chrome (Chromium-based; release update channel)

• Mozilla Firefox (release update channel)
The browser must be configured to allow the following:

• Cookies

• Pop-up windows for Collective Spaces (that is, Draft Space and Review Space) when
the application is called from Organize Space.

• A minimum resolution of 1024 x 768 pixels. The optimal resolution is 1280 x 1024
pixels or higher.

• The required DITA authoring tool:

• JustSystems XMetaL 18.0 x64

• JustSystems XMetaL 17.0 x64

• Syncro Soft Oxygen XML Author 26.x x64

• Syncro Soft Oxygen XML Author 25.x x64

• Acrolinx 5.0
Only 64-bit mode for the editors is approved and qualified.
Although multiple third-party XML editors are supported, we recommend choosing and
using a single third-party editor. RWS is not responsible for third-party editor XML and
DITA handling; behavior may differ depending on the XML editor. If you use more than
one editor, you may experience cross-compatibility issues related to DITA handling. If you
decide to use multiple third-party XML editors and if you experience cross-compatibility
issues with DITA handling, contact the XML editor vendor to address these issues.

Installer User Requirements
The users who can install Content Manager must have permissions and access as required.

An administrator user who has authorized access on the machines to be installed can install
the Content Manager software. The user must be able to:

• log on to the machine and have full access to the file system

• alter the registry

• have full access to the Services and Internet Information Services

A database administrator must set up the Content Manager database. The user must be
able to:

• create a database

• run scripts to set up the database

2Upgrading Content Manager
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Platform virtualization
You can deploy Content Manager software in a virtual environment (such as VMWare ESX).

You can deploy Content Manager software in a virtual environment if both of the following
conditions are true:
1. Content Manager supports the environment in its non-virtual form.
2. The platform vendor states that it supports the virtual form of this environment.

Note: If you run a software component in a virtual environment, the hardware
recommendations listed for that software component may not apply. The recommendations
listed apply to the software component if it is installed directly on such a hardware profile,
and not to the software component installed in a virtual environment that itself runs on the
recommended hardware profile.

For specific virtual platform support requests, contact the platform vendor. For specific
hardware recommendations, contact your virtual hardware solution vendor to find out how
the hardware recommendation for a direct installation translates into a hardware
recommendation for a virtual installation.

Firewalls and ports
In specific cases, firewall and ports may require special attention.

Firewalls and ports are an important part of your installation environment. Normally the
default settings do not interfere with a basic installation, but there is a variety of possibilities
regarding network and firewall configurations. This list provides some of the most common
points of attention and is by no means comprehensive.

The user responsible for the network setup knows all the items that should be checked in
your environment and has access to the specific technical documentation. Details can be
found in the Advanced topics for installers section.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions across the
internet.

Microsoft SQL Server
Microsoft SQL Server is the relational database management system (RDBMS) produced by
Microsoft.
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Oracle
Oracle Database, or simply Oracle, is the relational database management system (RDBMS)
produced by Oracle Corporation.

HTTPS (SSL)
HTTPS is a URI scheme used to indicate a secure HTTP connection. It refers to the
combination of a normal HTTP interaction over an encrypted Secure Sockets Layer (SSL).

Content Manager pre-upgrade tasks
Only if you are upgrading an existing instance of Content Manager, perform the pre-upgrade
tasks. These tasks consist of a backup and uninstallation of the old Content Manager
version. You should always make a complete backup of both project and database before
upgrading so you can restore to the current environment if necessary.

Note:

• Before beginning the upgrade it is recommended that you warn all users that the system
will be temporarily unavailable.

• No updates should be allowed beyond this point in time.

• You should plan to copy the whole of the Content Manager environment to a secure
destination.

• The whole of the Content Manager environment includes all Content Manager websites,
Content Manager website components, the Full Text Collection, the database backup(s),
and the Content Manager registry keys.

• Identify and plan to backup any custom files and information in the same way.

• Remember all Trisoft COM+ Applications and all Virtual Directories will have to be
removed as well.

Backing up the project
This backup operation makes a copy of everything installed and generated in this project.

About this task

This does a backup of the business components and used configuration and makes a full
copy of:

• the Full Text Collection

• all PublishService, ImportService, ExportService generated data

• all generated logging

Note: This backup can take a lot of time. You can do an initial clean up of all data that needs
no backup or do a manual backup of the necessary files and settings.
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Procedure
1. Login to the Windows system as the Administrator user or a user with Administrator

privileges (a user in the Administrator group).
2. In Windows Explorer, go to

C:\IShCD\yyyymmdd.CD.InfoShare<version_num>.ProjectName.IT\__InstallTool

3. Locate and double-click on InstallTool. exe.
4. Select the backup option.
5. Select the project that you want to backup and a location where you can safely store

everything.

Back up the database
Follow the procedure to back up the Microsoft SQL Server or Oracle database based on your
current configuration.

Note: The Oracle backup is much more complex than the Microsoft SQL Server backup.
The Microsoft SQL Server algorithm is described by its Windows UI. The Oracle procedure is
explained by command line tools so that it is valid for both a Windows and UNIX
environment).

Backing up the Microsoft SQL Server database
Follow this procedure to backup your Microsoft SQL Server database.

Procedure
1. Open SQL Server Management Studio.
2. Open the Databases folder.
3. Right-click your database.
4. Select Tasks > Back Up.
5. Backup type should be Full.
6. Enter a Name for the backup.

It is recommended that you use the format: yyyymmdd.projectname.bak to name the
backup.

7. Ensure that Backup set will expire: After 0 days
8. In the Destination pane at the bottom of the window, click Add.
9. Add a destination folder such as: yyyymmdd.projectname\SQLServer\Dump.
10. Click Options in the left pane and verify that the information is accurate:

• Backup to the existing media set.

• Append to the existing backup set.

• Verify backup when finished.
11. Click OK.
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The backup of the database starts.

Backing up the Oracle database
The description makes use of command line programs so that a person with a mixture of
Windows and UNIX knowledge can follow the procedure on any machine hosting Oracle.

This procedure guides a knowledgeable person through the configuration so that no
important steps are forgotten. However, it does not provide an explanations, or all the
options for each step.

The procedure includes suggestions about how to do the steps. It is out of scope of this
document to give a step-by-step explanation on basic Oracle maintenance. An Oracle DBA
can choose any option desired, as long as an exact restoration of the Content Manager
environment can be made.

Note:

• The description refers to a Windows environment concerning system variables and file
paths.

• The default database name is ISH.

Backing up the closed data files

You can just make a copy of closed data files. This action applies to cases when you are not
planning to change the location of the files, the character set or the Oracle version, so you
won't need to perform a complete export.

Procedure
1. To make a copy of closed data files, open a command line window and set the ORACLE_SID

and ORACLE_HOME environment variables. For example, on Windows:

set ORACLE_SID=ISH
set ORACLE_HOME=C:\Oracle\Product\VERSION\db_1

where VERSION is your Oracle version.
2. Start SQL Plus:

SQLPLUS /NOLOG

3. Force a database to close by typing the following. The goal is to do this quickly enough
so that no-one can make a connection and alter the database, ensuring that you copy a
stable file version.

shutdown abort
startup open
shutdown normal

All pending connections are closed by force. The startup open command checks the
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database and the shutdown normal command closes all database files.

Exporting the Oracle database

Perform a full database export if you need to be independent from version, character set or
location. Exporting from the previous Oracle version in order to import into the latest
supported version requires a specific procedure.

Procedure
1. Copy the file expdp.par from C:\IShCD\ yyyymmdd.CD.InfoShareVERSION.

ProjectName.IT\Database\InfoShareCM\Common\Oracle\expdp\to the dump directory
(DATA_PUMP_DIR) on the database server, where VERSION is your product version. The
dump directory is C:\Oracle\ admin\ DBNAME\dpdump\, where DBNAME is the name of your
database.

2. Go to the database server.
3. Modify the file names for the DUMPFILE and LOGFILE in the expdp.par file to match your

environment.
4. Open a command shell for your operating system.
5. On the command prompt, define the following environment variables, with the following

values:

Environmet variable Value

ORACLE_SID ISH

ORACLE_HOME the full path of the location where you
copied the application

6. Start SQLPlus by entering the following on the command prompt: sqlplus SYS AS
SYSDBA

7. Check if there is a dump directory DATA_PUMP_DIR:

SELECT directory_path FROM dba_directories WHERE directory_name ='DATA_
PUMP_DIR';

8. Make sure the dedicated isource database user has read and write access to the
directory:

GRANT read, write ON DIRECTORY data_pump_dir TO isource;

9. Exit SQLPlus to return to the command prompt
10. Execute the following command:

expdp parfile="C:\Oracle\admin\DBNAME\dpdump\expdp.par"

where DBNAME is the name of your database.
11. Provide the user name and password for the dedicated isource database user.

The dump file is exported to the dump directory. You can import it back after you have
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uninstalled the old version of Content Manager.

Upgrading your Background Task configuration
Only if you're upgrading Content Manager from a release older than Tridion Docs 15, you
must transform your existing Background Task configuration XML from old format to Tridion
Docs 15 format by running a Powershell script before starting your upgrade. During the
upgrade, the configuration XML will then be automatically transformed to Tridion Docs 15.1
format.

About this task

If you're upgrading from Tridion Docs 15, you can skip this task, because your Background
Task configuration will be upgraded for Tridion Docs 15.1automatically. But if you're
upgrading from an earlier version than Tridion Docs 15, you must run a Powershell script
before starting your upgrade.

Procedure
1. On your installation media, go to the folder __Resources\ InfoShareScripts\

Upgrade140xTo1500\.
2. Copy the script ConvertBackgroundTaskConfiguration. ps1 to your Content Manager

server machine.
3. The script looks for your Background Task configuration XML file in the folder

C:\InfoShare\ Web\ Author\ EnterViaUI\ . If you would like the conversion to occur in
another folder, edit the script to change the path.

4. Run the Powershell script.
The script reads Admin.XMLBackgroundTaskConfiguration. xml and creates a converted
file Admin.XMLBackgroundTaskConfiguration. converted.xml in the same folder.

5. Replace your existing XML Background Task configuration in the Content Manager
database with the contents of the converted file. You can do this in one of the following
ways:

• In the Tridion Docs web client user interface, select Settings and then XML
Background Task Settings. Clear the XML content you see, and paste the contents
of Admin.XMLBackgroundTaskConfiguration. converted.xml into it. Then select
Save to apply the change.

• Write a script that replaces the XML in the database with the contents of
Admin.XMLBackgroundTaskConfiguration. converted.xml, and run it.

What to do next

Your Background Task configuration is now in Tridion Docs 15 format. The upgrade process
will automatically upgrade it to the Tridion Docs 15.1 format.
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Uninstalling Content Manager
Removal of all Content Manager items of the installed environment is required before
starting an upgrade.

Before you begin
In the context of a Content Manager install or uninstall operation, before you run InstallTool
you need to make sure the Microsoft Distributed Transaction Coordinator MSDTC service is
running.

About this task
All items which were installed and in the installplan. xml are removed from your system.
Items which are not removed are:

• the Full Text Collection,

• all PublishService, ImportService, ExportService generated data,

• all generated logging,

• files that have changed after the initial installation (such as configuration files).

Procedure
1. Login to your Windows system as the Administrator user or a user with Administrator

privileges (a user in the Administrator group).
2. In Windows Explorer, go to the location where the previous installation software is

located, or to the CD that was used to install the current environment, to access the
correct version of the tool for uninstalling the software. Go to:
C:\IShCD\yyyymmdd.CD.InfoShare<version_num>.ProjectName.IT\__InstallTool

3. Locate and double-click on InstallTool. exe.
4. Select the uninstall option.
5. Select the project that you want to remove.
6. Uninstall.

Note: If the tool ends with errors you can find extensive info in installtool. log.

7. After the uninstall have completed, check that no Trisoft COM+ application remained
in Component Services > Computers > My Computer > COM+ Applications. Remove
remaining applications having a name starting with Trisoft-, if any.

Installing Content Manager databases
(installation only)
Only if you're installing Content Manager for the first time, set up your Content Manager
databases before proceeding with the installation of the Content Manager application server.
In addition, you need to install additional databases that are required for specific features.

The Content Manager databases can reside on either a Microsoft SQL Server or Oracle
database server. Your database server must be installed with the approved version of
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database software before beginning with these procedures.

Note: An Oracle setup is more complex than a Microsoft SQL Server setup. This is because
the Microsoft SQL Server installation and configuration is explained using a Windows user
interface. If you have the choice and are not an Oracle DBA, we advise that you install on
a Microsoft SQL Server platform.

Setting up the Content Manager database on
Microsoft SQL Server
Setting up the Content Manager database on Microsoft SQL Server requires configuration
of the server and creation of the database.

Configuring Microsoft SQL Server
The database setup is done on the Microsoft SQL server.

First read the pre-installation notes for SQL Server provided in this documentation.

The SQL Server installation has to be an AccentSensitive, CaseInsensitive, Unicode-ready
installation.

• If you are performing a fresh SQL Server installation, make sure that in the Database
engine Collation settings, Accent-sensitive is selected and Case-sensitive is not
selected.

• The typical Content Manager collation is SQL_Latin1_General_CP1_CI_AS (not the often
mistaken collation Latin1_General_CI_AS). Depending on the SQL Server version, the
collation SQL_Latin1_General_CP1_CI_AS is also displayed as Dictionary order,
caseinsensitive, for use with 1252 Character Set.

• You can check the collation name by issuing a query in SQL Server Management Studio
connected to your server.

• Select New Query then enter select ServerProperty('Collation').

• Select Execute.

• Verify that the result shows an Accent-sensitive (AS), Case-insensitive (CI) collation
name.
For more information refer to Collations in the SQL Server help files.

We recommend authentication based on named SQL Server login ID and on Windows
accounts.

• Check or modify authentication in SQL Server Management Studio, right-click
ServerName, then click Properties and select Security on the left pane.

• In the Server authentication pane on the right, select SQL Server and Windows
Authentication Mode.

SQL Server Agent is part of the SQL Server software.

• Check that this Windows Service is set to automatically start upon server reboot.
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In the Control Panel select System and Security then Administrative Tools then open
Services.

• Verify that SQL Server Agent startup type is Automatic.

Creating a Microsoft SQL Server database for Content
Manager
Create a database for the Content Manager data collection.

Procedure
1. Open SQL Server Management Studio.
2. Right-click on Databases then click New Database…
3. Enter a database name (e.g. ContentManager).
4. Click Options in the left pane.
5. In the Collation field, select: SQL_Latin1_General_CP1_CI_AS.
6. Select the appropriate Recovery model.

• Full: All transactions are logged. The recommended choice for production databases.

• Simple: A portion of the transactions are logged. A choice for some test or
development databases.

• Bulk-Logged: temporary setting used for specific large-scale bulk operations.

Note: The recovery model determines the number of transactions logged for later
system recovery. Whereas a Full model provides the best security with a higher points-
in-time for recovery, in some situations a Full model may cause logs to grow beyond
system's ability to process them. Check your database documentation for more
information.

7. In the Compatibility level field, select option corresponding to the version of SQL Server
you are using.

8. Click OK.

Importing data from the SQL dumpfile
Import the sample Content Manager database dump to validate the configuration and for
training purposes.

About this task
The backup data you import can come from the same version of SQL server or from a
previous version.
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Procedure
1. In the SQL Server Management Studio window, under Databases, right-click on the

database you created.
2. Click Tasks > Restore > Database.
3. In the General tab of the Restore Database window, select that you want to restore

from a Device.
a. Click the ellipsis button next to the Device field.
b. Click Add in the resulting Specify Backup window.
c. Locate and select the latest available dump provided on the installation CD in a

subfolder of the \Database\Dump\ folder.
d. Click OK.
e. The Database field under Source is populated with the name of the database in the

backup file.
f. In the Database field under Destination, select the name of the database you

created (e.g. ContentManager). This is the database that is to be populated with the
data from the backup/dump file.

Note: Make sure to select this after selecting the source otherwise it can default to
another database name.

4. In the Files tab of the Restore Database Window:
a. For the Rows Data select the data file path of the database you created (e.g.

C:\Program Files\Microsoft SQL Server\MSSQL14.SQL2017\MSSQL\DATA
\ContentManager.mdf).

b. For the Log select the log file path of the database you created (e.g. C:\Program
Files\Microsoft SQL Server\MSSQL14.SQL2017\MSSQL\DATA\ContentManager
_log.ldf).

5. Under the Options tab, select Overwrite the existing database.
6. Click OK. The database is restored.
7. After restoring the database, use SQL Server Management Studio to:

a. Open the Properties window,
b. Go to the Files tab,
c. Check and adapt (if necessary) the logical name.

File type Logical Name

Rows Data Set Logical Name to <dbname> (e.g.
ContentManager)

Log Set Logical Name to <dbname>_Log (e.g.
ContentManager_Log)

d. Check the recovery model and verify that Full is selected for the Recovery model.
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Removing the database user and schema
To ensure successful creation of a new database user and schema, delete the user that was
created when importing the sample data, as well as the schema of the same name if one
exists.

About this task
A database user in SQL Server exists on two levels, as an account on the SQL Server level
and as an account on your database. Depending on the kind of initial database setup dump
you received, you could have problems creating your new database user. Therefore, you
should delete the Content Manager database designated user (by default named isource)
and schema if one is present.

Note: The user listed within the created database part is to be removed and not the general
SQL Server part listed under Security > Logins.

Procedure
1. In the SQL Server Management Studio window, locate and open the tree under the

newly created database.
2. Open Security > Schemas.
3. Right-click on isource if it appears in the list, then click Delete.

A Delete Object window displays.

Note: The isource user may not exist under Schemas. If it does not exist, skip this and
the next step; continue to the step to open Security > Users.

4. Click OK to confirm the removal.
5. Open Security > Users.
6. Right-click on isource then click Delete.

A Delete Object window displays.
7. Click OK to confirm the removal.

Creating a new database user and schema
Add a new user to connect to the newly created database.

Procedure
1. On the database server, open the SQL Server Management Studio.
2. In the left pane under the server name open Security.
3. Right-click on Logins then select New Login…

A Login - New window displays.
4. In the Login name field, enter an user name (e.g. isource).
5. SQL Server Authentication should be selected. Enter a Password (e.g. isource) and

Confirm password for SQL Server Authentication.
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Note: SDL is not able to assist you if you do not know the password so it is advised to
store the password in a secure place.

6. Depending on your local password policy, you can enforce password policy and password
expiration.

Note: Keep in mind to change the connect string whenever you change the password
of the database user!

7. Use the drop down list to select the Default database; select your newly created
database.
No other changes are required for the General information.

8. Click Server Roles in the left pane.
9. Select (check the boxes next to) public and sysadmin in the right pane.

This allows the Content Manager DBUpgradeTool (DBUT) to fully execute all necessary
tasks to update your database with new releases.

Notice: If you want to reduce the server roles for everyday work, read “Optionally
minimize the database user's roles and permissions ” on page 19.

10. Click User Mapping in the left pane.
11. Select (check the boxes next to) the newly created database in the upper right pane.
12. In the upper right pane, in the Default Schema field for your database, enter dbo.
13. In the bottom pane, select (check the boxes next to) db_owner and public.

Notice: If you want to reduce the permissions for day to day usage, read “Optionally
minimize the database user's roles and permissions ” on page 19.

14. In the Login - New window, click Status in the left pane.
15. Verify that Grant is selected for Permission to connect to the database engine and

that Enabled is selected for Login.
16. Click OK.
17. Click File > Exit.

Optionally minimize the database user's roles and
permissions
Describes how to optionally reduce the roles and permissions of the database user for
everyday usage.
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About this task
Optional execution to minimize the permissions for normal operations outside of the
upgrade time frame.

Note: The following steps must be executed by a user who is administrator on the database
server.

Procedure
1. On the database server, open SQL Server Management Studio.
2. In the left pane under the server name, open Security > Logins.
3. Right-click the database user (e.g isource) and select Properties.
4. Revoke the server role sysadmin.

The server role sysadmin provides the ability to perform any activity on the server.
Content Manager DBUpgradeTool (DBUT) requires this server role to create the standard
database job and add extra (error) messages, for example. In order to allow DBUT to
fully execute all necessary tasks during an upgrade, we advice to reinstate the sysadmin
server role for the duration of that task. However, during everyday usage you can revoke
sysadmin using the following steps:
a. Select Server Roles in the left pane.
b. Deselect sysadmin in the right pane. Make sure that public is still selected.

5. Revoke database role db_owner.

Note: Revoking the database role db_owner should be done only after revoking the
server role sysadmin.

a. Select User Mapping in the left pane.
b. Select the correct database in the upper right pane.
c. In the bottom pane, un-check the box next to db_owner. Make sure that public is

still selected.
6. Select OK.
7. After revoking the database role db_owner, add the minimal required permissions.

In order for the Content Manager application to work without issues, the database user
needs the following permissions:

Name Description Usage

SELECT Retrieve information/
records from the
database

Everywhere

INSERT Insert new records into
the database

Everywhere

UPDATE Update records in the
database

Everywhere
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Name Description Usage

DELETE Delete records from the
database

Everywhere

EXECUTE Execute a stored
procedure in the
database

Stored procedures are used everywhere to:
• Create new objects (maps, topics, publica-

tions, users, LOV values...) and get the
newly created IDentity back.

• Delete objects
• Cleanup left-overs during a nightly

maintenance job
• ...

CREATE
TABLE

Create a new table DBUpgradeTool: during the upgrade of the
database from one version to another version,
we might introduce new tables.
Full-text search: out-of-the-box the tables for
the full-text search are created when you start
the Crawler for that installation for the first
time.

CREATE
VIEW

Create a new view DBUpgradeTool: during the upgrade of the
database from one version to another version,
we are dropping and recreating views.

CREATE
FUNCTION

Create a new function DBUpgradeTool: during the upgrade of the
database from one version to another version,
we are dropping and recreating functions.

CREATE
PROCEDURE

Create a new stored
procedure

DBUpgradeTool: During the upgrade of the
database from one version to another version,
we are dropping and recreating stored
procedures.

REFERENCES Create foreign keys
between two tables

DBUpgradeTool: During the upgrade of the
database from one version to another version,
we might introduce new tables and add new
foreign keys between those new tables and
the existing tables.
Full-text search: out-of-the-box the tables for
the full-text search are created when you start
the Crawler for that installation for the first
time, and we are also adding new foreign keys
between those new tables and the existing
tables.

ALTER ANY
SCHEMA

Create, alter and delete
objects in any schema

DBUpgradeTool: during the upgrade of the
database from one version to another version,
we are creating/altering/deleting tables,
views, functions, stored procedures... in the
schema dbo.

Full-text search: we need to create the tables
in the schema dbo for the full-text search.

You can grant the necessary permissions to the database user using the following
steps:
a. In SQL Server Management Studio open the following file:

C:\InfoShare\AppPROJECTSUFFIX\Database\InfoShareCM\Common\SQLServer\
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Tools\GrantPermissionsToDBUser.sql

where PROJECTSUFFIX is a suffix string.
b. If your database user is not isource, change isource to the correct database user.
c. Run the script as an administrator.
d. Connect with the database user (e.g. isource) and run the following query to check

that the database user has the required permissions.

SELECT * FROM fn_my_permissions(null, 'DATABASE')

Setting up the Content Manager database for
Oracle
The installation makes use of the Oracle Database Configuration Assistant (DBCA) and
command line programs to create and set up the database. This allows for anyone with a
mixture of Windows and UNIX knowledge to be able to set up an environment on any Oracle
hosting machine.

The configuration instructions refer to a Windows environment when noting system
variables and file paths.

These instructions guide a knowledgeable person through the configuration so that no
important steps are forgotten. However, it does not provide all explanations, or options
pertaining to each step.

Note: The default database name is ISH.

Note: In case of issue, be sure to check the troubleshooting section dedicated to the
database installation.

Configuring Oracle
Before creating your database, some configuration tasks are required.

Oracle database configuration requirements

The users who can configure Oracle must have permissions and access as required and be
familiar with Oracle and Microsoft environments.

The provided configuration instructions are written for administrators who have knowledge
of the Oracle and Microsoft environments.

Make sure that you satisfy the following requirements before you begin:

• Having a DBA role is required for a database migration.

• Reboot after Oracle installation for making sure that all Oracle environment settings are
available to you.
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Also note:

• All executed actions should be done in the same command window for making sure
that shell specific settings, such as ORACLE_SID or ORACLE_HOME, are available.

• All paths are examples only. Paths are system specific, so make sure that all file paths
are valid and contain the correct file(s), and beware of read-only flags on files.

• The default database name is ISH and is used in examples in the procedures.

Activating the Listener service for Oracle

You must start the Oracle listener service so that incoming client connection requests are
received and sent to the database server.

About this task
Activate the Listener service for Oracle in one of two ways:

• If a general listener is available, select it,

• Otherwise, create a specific listener for your database and activate it, following the
steps below.

Procedure
1. Start the Net Configuration Assistant. This Assistant is provided by Oracle.
2. Select Listener Configuration in the window that opens, then select Next".
3. Select Add in the following window, then select Next.
4. Enter a name for the new listener, then select Next.
5. Select TCP as the selected protocol in the list, then select Next.
6. Select Use the standard port of 1521 in the following window, then select Next, or

specify a custom port if using.
7. Complete the creation process by selecting Next again.

Creating the Oracle database for the Content Manager
Repository
Use the Database Configuration Assitant to create the Oracle database for the Content
Manager Repository, using a template.

Before you begin

To perform this task, you must be a member of the local Windows administration group, as
well as of the ORA_DBA group.
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About this task
To prepare your environment for the Oracle configuration, first copy the template file to
your server. The version mentioned below has been quality-tested with this version of
Content Manager.

Target directory on the server: ORACLEHOME\ assistants\ dbca\ templates\

Procedure
1. Go to the folder C:\InfoShare\App\Database\InfoShareCM\Common\Oracle\Oracle193.

Admin\.
2. Copy the template SDL-Trisoft. InfoShare-Database-Template. dbt to a location of

your choosing, for example, ORACLEHOME\ assistants\ dbca\ templates, where
ORACLEHOME is the Oracle home directory on the server.

3. Start the Database Configuration Assistant (DCA). This Assistant is provided by Oracle.
4. On the Database Operation page, select Create Database, then select Next.
5. Change the configuration mode to Advanced configuration, then select Next.
6. On the Database Template page, select SDL Trisoft InfoShare Database Template

(19), then select Next.
7. On the Database Identification page, fill in the Global Database Name field with the

database name; make sure that the Create as Container Database option is not
selected, and then select Next.

8. On the Storage Option page, do the following:
a. Select Use following for the database storage attributes.
b. In the Database files storage types list, select File System.
c. Fill in the Database files location field with the path to the database.
d. Select Next.

9. Leave the Fast Recovery Option page as is, then select Next.
10. On the Network Configuration page, select the Listener that you previously selected

or created for this database, then select Next.
11. Leave the Database Options page as is and select Next.
12. On the Configuration Options page, on the Memory tab, select Use Automatic Shared

Memory Management. You may want to adapt the values to your specific needs.
13. On the Configuration Options page, on the Sizing tab, you may want to increase the

processes value, depending on the size of your system. Each current database consumer
(end users, services, background tasks...) uses a process, so you need to set a sufficient
amount of them if you want all the consumers to be able to use the database in parallel.

14. Leave the rest of the Configuration Options page as is and select Next.
15. On the Management Options page, make sure that the specified port is unique and

select Next.
16. On the User Credentials page, fill in the password fields, then select Next.
17. On the Creation Option page, select Create database, then select Next.
18. On the Summary page, select Finish.
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Creating the designated ISOURCE database user
You must create the ISOURCE designated database user for the new database.

Procedure
1. If the folder C:\oracle\ admin\ ISH\create\ on the server does not exist, create it now.
2. Copy PACKAGEROOT\Database\InfoshareCM\Common\Oracle\Create\isrcuser.i(where

PACKAGEROOT is the root folder of the installation package) to the folder C:\oracle\
admin\ ISH\create\, and make sure the file is writable.

3. Check the paths, commands, usernames and passwords in the file. The examples in the
file are Windows-specific. Open the file in a plain-text editor and change the example
values as needed, especially the username and password of the designated user, to
match your environment.

4. Open a command shell for your operating system.
5. On the command prompt, define the following environment variables, with the following

values:

Environmet variable Value

ORACLE_SID ISH

ORACLE_HOME the full path of the location where you
copied the application

6. Start SQLPlus by entering the following on the command prompt: sqlplus SYS AS
SYSDBA

7. Enter the following commands from the same command prompt:

SPOOL C:\oracle\admin\ISH\create\dbadmin2.log
CONNECT SYS/CHANGE_ON_INSTALL AS SYSDBA
@C:\oracle\admin\ISH\create\isrcuser.i
CONNECT ISOURCE/isource
@?/RDBMS/ADMIN/catdbsyn.sql
SPOOL OFF;

Note: If you receive the error "SP2-0606: Cannot create SPOOL file C:\oracle\ admin\
ISH\create\dbadmin2.log", then you have no folder C:\oracle\admin\ISH\create\ .

Importing the data with Oracle
You can import sample data in order to validate your configuration or for training purposes.
Use the Data Pump Import tool for this.
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Procedure
1. If the folder C:\oracle\ admin\ ISH\dpdump\ does not exist on the server, create it now.
2. Copy PACKAGEROOT\Database\InfoShareCM\Common\Oracle\impdp\impdp.par(where

PACKAGEROOT is the root folder of your package) to the folder C:\oracle\ admin\ ISH\
dpdump\ , and make sure the file is writable.

3. Check the paths, commands, usernames and passwords in the file. The examples in the
file are Windows-specific. Open the file in a plain-text editor and change the example
values as needed, especially the name of the export file (DUMPFILE parameter) and the
designated schema owner (SCHEMAS parameter), to match your environment.

4. Open a command shell for your operating system.
5. On the command prompt, define the following environment variables, with the following

values:

Environmet variable Value

ORACLE_SID ISH

ORACLE_HOME the full path of the location where you
copied the application

6. Start SQLPlus by entering the following on the command prompt: sqlplus SYS AS
SYSDBA

7. Make sure the ISOURCE user has read and write access to the folder:

GRANT read, write ON DIRECTORY data_pump_dir TO isource;

8. Make sure the file from the Data Pump Export is copied to the DATA_PUMP_DIR:

SELECT directory_path FROM dba_directories WHERE directory_name =
'DATA_PUMP_DIR';

9. Exit SQLPlus, so you are back at the command prompt.
10. Perform the import by executing the following command:

impdp isource parfile="C:\oracle\admin\ISH\dpdump\impdp.par"

Disabling optimizer dynamic sampling
Dynamic sampling is a functionality that gathers statistics on the fly during query execution.
When switched on, it can adversely affect performance. For that reason, you should ensure
that the SYS user disables optimizer dynamic sampling in the Oracle database.

2 Upgrading Content Manager

26 Tridion Docs Content Manager upgrade guide



Procedure
1. Open a command shell for your operating system.
2. Start SQLPlus by entering the following on the command prompt: sqlplus SYS AS

SYSDBA

3. Enter the following command:

ALTER SYSTEM SET optimizer_dynamic_sampling=0

Validating the Oracle database
The newly imported Oracle database needs some packages, triggers and more to be
(re-)compiled for the database to be valid.

Before you begin

To perform this task, the ORACLE_SID and ORACLE_HOME environment variables must be set
correctly (this is normally done during the ISOURCE user creation).

Procedure
1. From a command shell in which where the ORACLE_SID and ORACLE_HOME environment

variables are set correctly, enter the following from the command prompt:

SQLPLUS /NOLOG

2. Enter the commands to validate the database. Do not use a script file.

CONNECT SYS/CHANGE_ON_INSTALL AS SYSDBA
@?/rdbms/admin/utlrp;

All objects in the database should be valid.

Editing tnsnames.ora for an Oracle database
For Oracle databases, the tnsnames.ora file defines the information for a connection to the
database server and to the database instance for the Content Manager repository. Modify
the file on the Oracle database server, and on all systems that communicate with the Oracle
database server.

About this task
If the Oracle database server and client software are installed on the same system, you
must edit the tnsnames.ora file under each Oracle home directory.
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Procedure
1. Sign in to the server as an administrator user.
2. Go to the folder ORACLEHOME\ network\ admin\ , where ORACLEHOME is the Oracle home

directory.
3. If this folder does not yet contain a file called tnsnames.ora, create an empty plain-text

document and save it as tnsnames.ora in this folder.
4. Open ORACLEHOME\ network\ admin\ tnsnames.ora in a plain-text editor.
5. Add the following to the file. Make sure that the first line starts on position 1, that is,

that it contains no leading whitespace.

NETSERVICENAME =
(DESCRIPTION =

(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)

(HOST = HOSTNAME)
(PORT = 1521))

)
(CONNECT_DATA =

(SERVICE_NAME = SERVICENAME)
)
)

where:

• NETSERVICENAME is an alias, for example, ISH.WORLD, that is used for a connect
descriptor.

• HOSTNAME is the IP address or name of the database server, for example,
devserver01 or 127.0.0.1.

• SERVICENAME is a combination of the db_name and db_domain values in the
C:\oracle\admin\ISH\pfile\PFILE\initISH.orafile. For example:

SERVICE_NAME = ISH.ORASERVER.DOMAIN.NAME

where ISH is the db_name value and ORASERVER.DOMAIN.NAME is the db_domain
value in the initISH.ora file.

6. Save and close the file.

Analyzing the Oracle database
After the import, run a script that creates statistics used by the queries.

Before you begin

ORACLE_SID and ORACLE_HOME variables are set correctly (this is normally done during the
ISOURCE user creation).
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Procedure
1. At a command prompt where the environment variables ORACLE_SID and ORACLE_HOME

are set correctly (this is normally done during the ISOURCE user creation), enter the
following commands:

SQLPLUS /NOLOG
CONNECT ISOURCE/isource

2. Run the PACKAGEROOT\Database\InfoshareCM\Common\Oracle\Tools\FullAnalyze.sql
script, where PACKAGEROOTis the root folder of your installation package.

Creating databases for Content Manager
security
To implement security for Content Manager clients, you need to create three additional
databases.

Databases
The following table describes the databases and their functions:

Feature Description

Tridion Access Management Tridion Access Management (or simplyAccess Management)
provides implementors with a simplified approach to
identity management and gives administrators a central
location for ongoing management of access to applications.

Backend for frontend Backend for frontend, or BFF, refers to an architectural
pattern that uses a middle layer between the frontend
clients and the backend. BFF also refers to the layer itself
and each client has a dedicated BFF. A single BFF database
is used for the various BFFs.

Tridion Docs Identity
Provider

Database server requirements
The Content Manager databases can reside on either an Microsoft SQL Server or Oracle
database server. Your database server must be installed with the approved version of
database software before beginning with these procedures.

Note: An Oracle setup is more complex than a Microsoft SQL Server setup. If you have the
choice and are not an Oracle DBA, we advise that you install on a Microsoft SQL Server
platform.

To complete this task, you need access to a database server machine that runs a supported
database version. Database support is the same as for Content Manager.
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PowerShell script requirements
To create these databases, you run PowerShell database scripts, which require a machine
that meets the following requirements:

PowerShell
You require Microsoft Windows PowerShell 5.1. You can download Microsoft Windows
Management Framework 5.1, which includes Microsoft Windows PowerShell 5.1, from this
location: http://aka.ms/wmf5download 

Operating system
You require an operating system that supports both the required PowerShell software
and any software for the database you intend to install. As a general rule, ensure that the
latest (security) updates are installed on your operating system.

Database client software
For Oracle databases, you require both of the following:

• Oracle Services for Microsoft Transaction Server (ORAMTS)

• Oracle Data Provider for .NET (ODP.NET)

For maintenance, configuration and debugging purposes, RWS recommends that you
also install the Oracle SQL Developer PL/SQL IDE (or SQL*Plus) and Oracle Net.

Environment variables
For Oracle databases where you have defined a Net Service Name for each database in a
tnsnames.ora file, you must also have defined a TNS_ADMIN environment variable. Set it to
the directory where tnsnames.ora resides.

Microsoft .NET Framework
You require a .NET Framework version. The one to use depends on your Windows Server
operating system version:

• If you run Microsoft Windows Server 2022, you can use Microsoft .NET Framework
4.8.1. You can download Microsoft .NET Framework 4.8.1 from the following location:
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net481 

• If you run Microsoft Windows Server 2019 x64, you must use Microsoft .NET
Framework 4.8. You can download Microsoft .NET Framework 4.8 from the following
location: https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48 

Security
You need to be logged in as a user with sufficient security clearance. For example, to run
a script that installs a database, you must be logged in as a user with rights to create that
database.

Creating an SQL Tridion Docs administrator user for Oracle
Tridion Docs ships with an SQL script that creates a Tridion Docs administrator user. After
running the script, you can use this new user when you run a PowerShell script to create a
database for Content Manager security. The privileges and roles created for this user are the
minimum requirements for database installation.
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Procedure
1. On your Tridion Docs installation media, go to the folder Database\ Shared\ Scripts\

Oracle\Create\.
2. Run the SQL script TridionSYSUser. sql (say, from SQL*Plus).
3. When prompted, give the following information:

Username The name of the Tridion Docs administrator user that can create
the database. RWS proposes the user name TRIDION_DOCS_SYS.

Note: You cannot use a user that must connect as SYSOPER or
SYSDBA with the PowerShell script.

Password The password of this user

Default
tablespace

The default tablespace for objects the user creates

Temporary
tablespace

The tablespace for the user's temporary segments

What to do next
Once this user has been created, you can proceed to create your databases for Content
Manager security.

Creating the Access Management database
Create the Access Management database using the provided PowerShell script.

Before you begin

• To complete this task, you need access to a database server machine that runs a
supported database version. Database support is the same as for Content Manager.

About this task

Procedure
1. On your database server machine, open a PowerShell prompt.
2. For Oracle databases, specify a host, port, service name and other connection

information for the PowerShell script, either before or while running the script:

• Before you run the script, you can define a variable in PowerShell, let's say
$MyDatabaseServer, and set it to your connection string. When you invoke the
script, you then append the string -DatabaseServer $MyDatabaseServer to the
PowerShell command.

• Alternatively, you can just invoke the script as is, and while you run the script,
PowerShell prompts you for a value for Net Service, and you can then enter one of
the following:

• Enter the Net Service Name for this database if you have defined a Net Service
Name in a tnsnames.ora file and specified the location of that file in a TNS_ADMIN
environment variable.

• Enter the string %manual% to let the script prompt you for the following: Host
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name, Port and Service name.

• Enter the actual connection string directly on a single line if you have more to
provide than just a host, port and service name. For example:

(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = myhost)(PORT =
1521))(CONNECT_DATA = (SERVICE_NAME = ora)))

3. Run the following PowerShell command, following the instructions that appear:

& '.\Install Access Management database.ps1'

By completing this step, you have created the Access Management database.

Creating the Tridion Docs Identity Provider database
Create the database for Tridion Docs Identity Provider using the provided PowerShell script.

Before you begin

• To complete this task, you need access to a database server machine that runs a
supported database version. Database support is the same as for Content Manager.

• To run PowerShell database scripts for this database, the machine must meet the
requirements described in “Creating databases for Content Manager security ” on page
29.

Procedure
1. On your database server machine, open a PowerShell prompt.
2. In the location of your Tridion Docs installation media, navigate to the folder for the

type of database you are creating:

• For a Microsoft SQL Server database: Database\ InfoShareID\ SQLServer\

• For an Oracle database:Database\InfoShareID\Oracle\
3. For Oracle databases, specify a host, port, service name and other connection

information for the PowerShell script, either before or while running the script:

• Before you run the script, you can define a variable in PowerShell, let's say
$MyDatabaseServer, and set it to your connection string. When you invoke the
script, you then append the string -DatabaseServer $MyDatabaseServer to the
PowerShell command.

• Alternatively, you can just invoke the script as is, and while you run the script,
PowerShell prompts you for a value for Net Service, and you can then enter one of
the following:

• Enter the Net Service Name for this database if you have defined a Net Service
Name in a tnsnames.ora file and specified the location of that file in a TNS_ADMIN
environment variable.

• Enter the string %manual% to let the script prompt you for the following: Host
name, Port and Service name.

• Enter the actual connection string directly on a single line if you have more to
provide than just a host, port and service name. For example:
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(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = myhost)(PORT =
1521))(CONNECT_DATA = (SERVICE_NAME = ora)))

4. Run the following PowerShell command, following the instructions that appear:

& '.\Install Infoshare Identity Provider database.ps1'

By completing this step, you have created the InfoShareID database.

Creating the backend for frontend database
Create the backend for frontend (BFF) database using the provided PowerShell script.

Before you begin

• To complete this task, you need access to a database server machine that runs a
supported database version. Database support is the same as for Content Manager.

• To run PowerShell database scripts for this database, the machine must meet the
requirements described in “Creating databases for Content Manager security ” on page
29.

About this task
Backend for frontend, or BFF, refers to an architectural pattern that uses a middle layer
between the frontend clients and the backend. BFF also refers to the layer itself and each
client has a dedicated BFF. A single BFF database is used for the various BFFs.

Procedure
1. On your database server machine, open a PowerShell prompt.
2. For Oracle databases, specify a host, port, service name and other connection

information for the PowerShell script, either before or while running the script:

• Before you run the script, you can define a variable in PowerShell, let's say
$MyDatabaseServer, and set it to your connection string. When you invoke the
script, you then append the string -DatabaseServer $MyDatabaseServer to the
PowerShell command.

• Alternatively, you can just invoke the script as is, and while you run the script,
PowerShell prompts you for a value for Net Service, and you can then enter one of
the following:

• Enter the Net Service Name for this database if you have defined a Net Service
Name in a tnsnames.ora file and specified the location of that file in a TNS_ADMIN
environment variable.

• Enter the string %manual% to let the script prompt you for the following: Host
name, Port and Service name.

• Enter the actual connection string directly on a single line if you have more to
provide than just a host, port and service name. For example:

(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = myhost)(PORT =
1521))(CONNECT_DATA = (SERVICE_NAME = ora)))
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3. Run the following PowerShell command, following the instructions that appear:

& '.\Install Infoshare Backend For Frontend database.ps1'

By completing this step, you have created the backend for frontend database.

Creating the Metrics database
Create the Metrics database using the provided PowerShell script.

Before you begin

• To complete this task, you need access to a database server machine that runs a
supported database version. Database support is the same as for Content Manager.

• To run PowerShell database scripts for this database, the machine must meet the
requirements described in “Creating databases for Content Manager security ” on page
29.

About this task
Metrics is a feature that gives customers a variety of metrics, extracted from the content
they create. The feature extracts technical documentation metrics that consist of productivity
metrics as well as a Return on Investment value, which is based on the level of content
reuse that is measured. Gathered data is collected and aggregated in the Metrics database.
The Metrics web service fetches the data from the database and serves it up to its clients.

Procedure
1. On your database server machine, open a PowerShell prompt.
2. For Oracle databases, specify a host, port, service name and other connection

information for the PowerShell script, either before or while running the script:

• Before you run the script, you can define a variable in PowerShell, let's say
$MyDatabaseServer, and set it to your connection string. When you invoke the
script, you then append the string -DatabaseServer $MyDatabaseServer to the
PowerShell command.

• Alternatively, you can just invoke the script as is, and while you run the script,
PowerShell prompts you for a value for Net Service, and you can then enter one of
the following:

• Enter the Net Service Name for this database if you have defined a Net Service
Name in a tnsnames.ora file and specified the location of that file in a TNS_ADMIN
environment variable.

• Enter the string %manual% to let the script prompt you for the following: Host
name, Port and Service name.

• Enter the actual connection string directly on a single line if you have more to
provide than just a host, port and service name. For example:

(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = myhost)(PORT =
1521))(CONNECT_DATA = (SERVICE_NAME = ora)))

3. Run the following PowerShell command, following the instructions that appear:
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& '.\Install Infoshare Metrics database.ps1'

By completing this step, you have created the Metrics database.

Installing the Content Manager server
You must install and configure the application and web server to use the Content Manager
application, allowing you to connect to the repository.

Most of the Content Manager server installation process is automated. At the end of the
process, some options must be set manually.

Be sure to check the installation requirements before initiating the application server
installation.

Configuring database connection strings
Before installing the Content Manager software, you need to configure the connection
between the application server and the Content Manager database. The connection is
defined with a database connection string.

The topics in this section explain in detail the tasks involved in configuring connection strings.

Important: If you are upgrading to Tridion Docs 15.1 from a version earlier than release
15, you must create a new connection string. You cannot reuse an existing string in this
upgrade scenario because Tridion Docs 15 introduces a stricter policy for keywords in
connection strings.

The following steps summarize the process in the order the tasks must be performed:
1. Create the connection string according to the requirements for the type of database

you are using, that is, for Microsoft SQL Server or Oracle.
2. If using an Oracle database, update the tnsnames.ora file.
3. Add the connection string to the inputparameter. xml file.

The final step is part of the broader task of editing the inputparameter. xml file. The next
topic in this section provides the details on this file. Once that is done, you are ready to run
the Content Manager InstallTool. After completing the installation process, the system adds
the connection string to the connect setting in the server's registry.

2Upgrading Content Manager

35Tridion Docs Content Manager upgrade guide



Sample database connection strings
This topic provides examples of connection strings for SQL Server and Oracle databases.

Connection strings for SQL Server
The following is an example of a standard connection string for Microsoft SQL Server:

Provider=MSOLEDBSQL.1;Data Source=myServerAddress;Initial Catalog=
myDataBase;User Id=myUsername;Password=myPassword;

The following is an example of a standard connection string for Microsoft SQL Server that
includes a trusted connection using Integrated Security:

Provider=MSOLEDBSQL.1;Data Source=myServerAddress;Initial Catalog=myDataBase
;Integrated Security=SSPI;

When using Integrated Security, the user specified in the Input Parameter OSUser used by
InstallTool, should have sufficient privileges on the database.

Note:

• The provider shown is the Microsoft OLE DB Driver for SQL Server. Only this provider is
supported.

• Communication between the application server and the database server is (by default)
encrypted.
One of the following is required:

• A valid certificate issued by a certificate authority (CA) is installed on the Microsoft
SQL Server.

• The connection string contains "Trust server certificate = True" to indicate that you
trust the server with a self-signed certificate.

• Ensure that the connection string does not contain any of the following as keywords:
Access Token, Initial File Name and Server SPN.

Connection strings for Oracle
The following is an example of a standard connection string for Oracle:

Provider=OraOLEDB.Oracle.1;Data Source=MyOracleDB;User Id=myUsername;
Password=myPassword;

The following is an example of a standard connection string for Oracle with OS
Authentication:

Provider=OraOLEDB.Oracle.1;Persist Security Info=False;User ID=/;Data Source
=MyOracleDB

Note:
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• The provider shown is the Oracle Provider for OLE DB. Only this provider is supported.

• The data source is the net_service_name entry in the Oracle_home\ network\ admin\
tnsnames.ora file.

Editing tnsnames.ora for an Oracle database
For Oracle databases, the tnsnames.ora file defines the information for a connection to the
database server and to the database instance for the Content Manager repository. Modify
the file on the Oracle database server, and on all systems that communicate with the Oracle
database server.

About this task
If the Oracle database server and client software are installed on the same system, you
must edit the tnsnames.ora file under each Oracle home directory.

Procedure
1. Sign in to the server as an administrator user.
2. Go to the folder ORACLEHOME\ network\ admin\ , where ORACLEHOME is the Oracle home

directory.
3. If this folder does not yet contain a file called tnsnames.ora, create an empty plain-text

document and save it as tnsnames.ora in this folder.
4. Open ORACLEHOME\ network\ admin\ tnsnames.ora in a plain-text editor.
5. Add the following to the file. Make sure that the first line starts on position 1, that is,

that it contains no leading whitespace.

NETSERVICENAME =
(DESCRIPTION =

(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)

(HOST = HOSTNAME)
(PORT = 1521))

)
(CONNECT_DATA =

(SERVICE_NAME = SERVICENAME)
)
)

where:

• NETSERVICENAME is an alias, for example, ISH.WORLD, that is used for a connect
descriptor.

• HOSTNAME is the IP address or name of the database server, for example,
devserver01 or 127.0.0.1.

• SERVICENAME is a combination of the db_name and db_domain values in the
C:\oracle\admin\ISH\pfile\PFILE\initISH.orafile. For example:

SERVICE_NAME = ISH.ORASERVER.DOMAIN.NAME

where ISH is the db_name value and ORASERVER.DOMAIN.NAME is the db_domain
value in the initISH.ora file.
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6. Save and close the file.

Preparing the inputparameters. xmlfile
The inputparameters. xml file stores parameters that are used by the Content Manager
installer; therefore, the file must accurately reflect your environment before proceeding with
installation. Only the mandatory parameters need to be considered in the vast majority of
installations. The optional parameters cover rare and advanced cases.

Before you begin
Before modifying the inputparameters. xml file, you need to do the following:

• Obtain and install the certificate.

• Configure HTTPS bindings.

Procedure
1. From the __InstallTool folder of the installation directory, open the inputparameters.

xml file for editing.
2. Edit the values of all mandatory parameters. Refer to the related topic for details.

Each parameter in the inputparameters. xml file has the following syntax:

<param name="parameter">
<currentvalue>value</currentvalue>
<defaultvalue>example_value</defaultvalue>
<description>description_of_how_used</description>
<validate>if_validated</validate>

</param>

The XML elements perform the following functions:

<currentvalue>
Contains the value that is used by the Content Manager installer.

<defaultvalue>
Contains a predefined value as an example. Do not use the predefined value as a
default value; its only purpose is to serve as an example.

<description>
Contains details describing how the current value of the parameter is used.

<validate>
Defines whether the value of the parameter is validated or not. If the element is
empty, no validation is performed. The <validate> values are provided, and they
should not be modified.

3. Edit the values of all optional parameters, as needed. Refer to the related topic for
details.

4. Save and close the file.
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Mandatory input parameters in inputparameters. xml
This section lists and describes the main input parameters contained in the
inputparameters. xml file, the ones you need to set for any installation. Some of these input
parameters are mandatory: you need to set them in order for the installation to work
correctly.

osuser
The username of the designated operating system user. This user must be a local
administrator and have the correct regional settings.

ospassword
The password of the designated operating system user. Set the password so that it never
expires.

connectstring
The connection string for the Content Manager database (InfoShareCM). See the default
suggestion or the documentation under "Sample database connection strings." For
Oracle, 'Provider=OraOLEDB.Oracle.1;Data Source=MyOracleDB;User Id=myUsername;
Password=myPassword;' should be used.

ishamconnectstring
The connection string for the Access Management database (InfoShareAM).

ishbffconnectstring
The connection string for the backend-for-frontend database (InfoShareBFF).

ishidconnectstring
The connection string for the Tridion Docs Identity Provider database (InfoShareID).

ishmetricsconnectstring
The connection string for the Tridion Docs Metrics database (InfoShareMetrics).

apppath
The root directory for the Content Manager installation. By default, this is set to
C:\InfoShare.

baseurl
The first part of the URL that your InfoShare users will need to browse to use it, https://
ish.example.com for example.

ps_java_home
The full path to an OpenJDK JAVA_HOME folder. This allows you to specify your path and, if
needed, switch between compatible versions. Refer to the documentation for the version
tested against.

Note: Do not use environment variables or put your file path in quotation marks.

serviceusername
Specify an existing InfoShare internal user profile Username to use for services like
TranslationBuilder. Authentication happens over AuthenticationContext or using the
deprecated WS-Trust authentication.
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servicepassword
Specify an existing InfoShare internal user profile Password to use for services like
TranslationBuilder. Authentication happens over AuthenticationContext or deprecated
WS-Trust authentication.

serviceaccountclientid
Specify the InfoShare user profile Username to use for services like TranslationOrganizer.
When the install tool for Access Management (ISHAM) is run, the value specified here is
used, and thus becomes the service account client ID for requesting an access token from
Access Management.

serviceaccountclientsecret
Specify any secret of your choice (it could be a GUID, for example) to use for services like
TranslationOrganizer. When the install tool for Access Management (ISHAM) is run, the
value specified here is used, and thus becomes the service account secret for requesting
an access token from Access Management.

metricsserviceclientid
Specify the client identifier that the background task service should use to communicate
with the Metrics API. When the install tool for Access Management (ISHAM) is run, the
value specified here is used, and thus becomes the Metrics service client ID for requesting
an access token from Access Management.

metricsserviceclientsecret
Specify any secret of your choice (it could be a GUID, for example) to use for
communicating with the Metrics API. When the install tool for Access Management
(ISHAM) is run, the value specified here is used, and thus becomes the Metrics service
client secret for requesting an access token from Access Management.

Optional input parameters in inputparameters. xml
By default, the file inputparameters. xml contains only a set of mandatory properties.
Optional parameters are either calculated by Content Manager, or they have a predefined
default value. This section lists and describes the optional input parameters that you can set
in the inputparameters. xml file. Only Content Manager experts should change these
parameters.

Optional parameters

Note: When you provide a value to a parameter that is calculated by default, the parameter
is set to your value and is no longer calculated.
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Name Description Default value

projectsuffix Whenever more than one project is
installed, the projectsuffix value
indicates the project. Remember to
make web application names and
service ports unique as well. The
value of this parameter is given as
PROJECTSUFFIX in the rest of this
table.

(none)

webpath The path of the folder in which the
website folder is created.

APPPATH (calculated)

datapath The path of the folder in which the
data folder is created. For example,
when the datapath is c:\InfoShare
the logs will be created in the
folder c:\InfoShare\Data\Logs\.

APPPATH (calculated)

workspacepath This path is a temporary folder in
which all the folders and files are
copied and modified before the
actual installation.

APPPATH\_Workspace
(calculated)

infosharecswebappnameThe name of the web application
that offers Organize Space, Draft
Space and Review Space Services.

ISHCS + PROJECTSUFFIX

infoshareauthorwebappnameThe name of the Content Manager
web application hosting
ClientConfig and ASP.NET pages.

ISHCM + PROJECTSUFFIX

infosharewswebappnameThe name of the web application
for Content Manager web services.

ISHWS + PROJECTSUFFIX

infosharestswebappnameThe name of the web application
with the deprecated Content
Manager Secure Token Service
(STS).

ISHSTS + PROJECTSUFFIX

websitename The name of the website in which
all web applications will be created.

Default Web Site

infoshareidwebappnameThe name of the web application
for the Tridion Docs Identity
Provider.

ISHID + PROJECTSUFFIX

infoshareextwebappnameThe name of the web application
with the Web Extensions Service
hosting customizations for
Organize Space.

ISHEXT + PROJECTSUFFIX

infoshareamwebappnameThe name of the Access
Management web application.

ISHAM + PROJECTSUFFIX

infosharemetricswebappnameThe name of the Metrics web
application.

ISHMT + PROJECTSUFFIX
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Name Description Default value

localservicehostname Indicates the local service
hostname part of the base URL.
This can be localhost or the
machine name. It will be used by all
service side components that
access the WCF Services on the
same box.

the NetBIOS name of this
local computer (calculated)

ps_fo_processor The fully qualified file name of the
XSL-FO processor, for example
C:\Program Files\AntennaHouse
\AHFormatterV6\AHFCmd.exe.

the highest installed version
in %ProgramFiles%
(calculated).

ps_htmlhelp_
processor

The fully qualified file name of the
HTML Help processor.

C:\Program Files
(x86)\HTML Help Workshop
\hhc.exe

Note: Do not use
environment variables or
quotation marks.

ps_javahelp_home The full path to a JavaHelp JHHOME
folder, used when you want to
publish with the JavaHelp output
type.

C:\javahelp\jh2.0

Note: Do not use
environment variables or
quotation marks.

solrlucene_
service_port

The port that the SolrLucene
service uses. This port must be
unique for each Content Manager
instance installed on a server.

8983

basehostname The hostname part of the base
URL. This value will be calculated
using BASEURL as input, stripping
the protocol http or https (e.g.
ish.example.com)

BASEURL (calculated)

servicecertificatethumbprintThe thumbprint of an already
installed certificate (e.g.
A43489159A520F0D93D032CCAF37E7FE20A8B419)
for unique service identification.
You can repurpose your SSL
certificate. Note that all your linked
web application servers in a farm
should offer the same trusted
certificate.

from HTTPS binding of
websitename

servicecertificateval-
idationmode

The validation mode specified here
decides how the application-to-
application communication
validates service certificates
(specified in
servicecertificatethumbprint).
The allowed options are:
ChainTrust, PeerTrust,
PeerOrChainTrust or None. Setting
the mode to None causes any
certificate to be accepted.

ChainTrust
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Name Description Default value

servicecertificatesub-
jectname

Specify the subject name of an
already installed certificate for
unique service identification. You
can repurpose your SSL certificate.
Note that all your linked web
application servers in a farm should
offer the same trusted certificate.

from HTTPS binding of
websitename

Executing the InstallTool
Use the Content Manager InstallTool to install and merge all standard and customer specific
project files.

Before you begin
In the context of a Content Manager install or uninstall operation, before you run InstallTool
you need to make sure the Microsoft Distributed Transaction Coordinator MSDTC service is
running.

Procedure
1. Login to your Windows system as a Content Manager user with the Administrator user

role.
2. In Windows Explorer, go to

C:\IShCD\yyyymmdd.CD.InfoShare<version_num>\ProjectName.IT\__InstallTool

3. Locate and double-click on InstallTool. exe.
4. Select the Install option by entering the number 2.
5. Hit enter to respond to all questions; the default options should be sufficient.

All standard and customer specific project files are merged and installed. All required
services have to be started manually (the Crawler, SolrLucene, IISAdmin, W3SVC).

Identifying reverse proxies
Various reverse proxy servers can be used in combination with Content Manager. Using
reverse proxy servers may result in connection problems to the Content Manager repository.
You can check the BASEURL to verify that it is not causing any problem in your internet
browser.

When you identify reverse proxy servers, verify that the following URLs do not cause any
problems in the internet browser:

• BASEURL/ISHWS/Application.asmx?wsdl

• BASEURL/ISHWS/Application.asmx?disco

The BASEURL is specified in the inputparameters. xml file used by the Content Manager
installer.

The BASEURL must use the https schema. It must also reference a hostname that is valid for
the SSL certificate.
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For example if the server has a SSL certificate configured with CN=example.com then the
BASEURL must be https://example.com.

Example:

<param name="baseurl">
<currentvalue>https://example.com</currentvalue>
<defaultvalue>https://example.com</defaultvalue>
<validate/>
</param>

Make sure that the URLs are accessible by your users.

Applying Update 1 to your Tridion Docs
15.1 Content Manager implementation
Only if you are applying Update 1 to a Tridion Docs 15.1 setup, run a number of PowerShell
scripts. First, update your Content Managerapplication server or servers, and then update
your Content Manager databases.

Procedure
1. Unzip the Update 1 ZIP file, which is called

DATE.UPDATE.InfoShare.15.1.BUILDNUMBER.1.Trisoft-DITA-OT. zip, where DATE is the
release date of the update, and BUILDNUMBER is the specific build number of the
update, to its own DATE.UPDATE.InfoShare.15.1.BUILDNUMBER.1.Trisoft-DITA-OT\
folder under the Tridion Docs installation extraction path (C:\IshCD\ by default).

What to do next
The Update 1 package is now ready for applying.

Applying Update 1 to your Tridion Docs 15.1
Content Manager application server or servers
Only if you are applying Update 1 to a Tridion Docs 15.1 setup, for each of your Content
Managerapplication servers, run a PowerShell script.

Before you begin

You need to run the PowerShell script as an administrator.
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Procedure
1. Access one of your Content Manager application servers.
2. Open a PowerShell prompt as an administrator.
3. Go to the folder

C:\IshCD\DATE.UPDATE.InfoShare.15.1.BUILDNUMBER.1.Trisoft-DITA-OT\ , where
DATE is the date of the release of Update 1, and BUILDNUMBER is the specific build
number of the release.

4. Do one of the following:

• If you still have at least one other Content Manager application server to update
after this one, invoke the command _Update-ISHWebAppServer.ps1
-SkipStartISHDeployment

• If this is your last (or only) Content Manager application server to update, invoke
the command _Update-ISHWebAppServer. ps1

Note: If there are multiple ISHDeployment instances running on this server (you can
find out by using the Get-ISHDeployment cmdlet), also add
-IshDeploymentNameISHDEPLOYMENTNAME, where ISHDEPLOYMENTNAME is the name of
the variable that contains the name of your ISHDeployment (for example,
$ishDeploymentName).

5. If you still have at least one other Content Manager application server to update, repeat
steps 1-4.

Applying Update 1 to your Tridion Docs 15.1
databases
Only if you are upgrading from Tridion Docs 15.1, update your databases by running a
PowerShell script.

Before you begin

You need to run the PowerShell script as an administrator.

Procedure
1. Open a PowerShell prompt as an administrator.
2. Go to the folder

C:\IshCD\DATE.UPDATE.InfoShare.15.1.BUILDNUMBER.1.Trisoft-DITA-OT\ , where
DATE is the date of the release of Update 1, and BUILDNUMBER is the specific build
number of the release.

3. Use the ISHRemote New-IshSession command to create a new session. For more
information about this command, enter Get-Help New-IshSession -Full

4. Update the databases by executing the following command:

_Update-ISHDatabases.ps1 -IshSession SESSION
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where SESSION is the name of the variable (for example, $ishSession) in which you
stored the return value of your New-IshSession.

Note: If there are multiple ISHDeployment instances running on this server (you can
find out by using the Get-ISHDeployment cmdlet), also add
-IshDeploymentNameISHDEPLOYMENTNAME, where ISHDEPLOYMENTNAME is the name of
the variable that contains the name of your ISHDeployment (for example,
$ishDeploymentName).

Upgrading Access Management
To upgrade Access Management, you need to upgrade the database, uninstall the existing
service and then install the version of the service that comes with Tridion Docs 15.1.

Upgrading the Access Management database
If you have Access Management installed as a part of your implementation, upgrade your
existing Oracle or Microsoft SQL Server database by running a PowerShell script.

Before you begin
To upgrade the Access Management database itself, you need details of DBA and user
credentials and the name of the database.

To run PowerShell database scripts for databases on the Content Manager side, you require
a machine that meets the following requirements:

PowerShell
You require Microsoft Windows PowerShell 5.1. You can download Microsoft Windows
Management Framework 5.1, which includes Microsoft Windows PowerShell 5.1, from this
location: http://aka.ms/wmf5download 

Operating system
You require an operating system that supports both the required PowerShell software
and any software for the database you intend to install. As a general rule, ensure that the
latest (security) updates are installed on your operating system.

Database client software
For Oracle databases, you require both of the following:

• Oracle Services for Microsoft Transaction Server (ORAMTS)

• Oracle Data Provider for .NET (ODP.NET)

For maintenance, configuration and debugging purposes, RWS recommends that you
also install the Oracle SQL Developer PL/SQL IDE (or SQL*Plus) and Oracle Net.

Environment variables
For Oracle databases where you have defined a Net Service Name for each database in a
tnsnames.ora file, you must also have defined a TNS_ADMIN environment variable. Set it to
the directory where tnsnames.ora resides.
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Microsoft .NET Framework
You require a .NET Framework version. The one to use depends on your Windows Server
operating system version:

• If you run Microsoft Windows Server 2022, you can use Microsoft .NET Framework
4.8.1. You can download Microsoft .NET Framework 4.8.1 from the following location:
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net481 

• If you run Microsoft Windows Server 2019 x64, you must use Microsoft .NET
Framework 4.8. You can download Microsoft .NET Framework 4.8 from the following
location: https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48 

Security
You need to be logged in as a user with sufficient security clearance. For example, to run
a script that installs a database, you must be logged in as a user with rights to create that
database.

Procedure
1. Close all connections to your database server.
2. If you have not done so already, make a back-up of your database for safety reasons.
3. On a system that meets the prerequisites for database installation and upgrade scripts,

open PowerShell.
4. In PowerShell, depending on your database navigate to one of the following folders on

the installation media:

• For a Microsoft SQL Server, AWS RDS-MSSQL or Microsoft Azure database, navigate
to Database\MSSQL\

• For an Oracle database, navigate to Database\ Oracle\
5. For a Microsoft SQL Server database, you can add an -IntegratedSecurity switch to let

the script know that you want to use the current Windows account credentials to access
the database, rather than specifying a database username and password.

6. For Oracle databases, specify a host, port, service name and other connection
information for the PowerShell script, either before or while running the script:

• Before you run the script, you can define a variable in PowerShell, let's say
$MyDatabaseServer, and set it to your connection string. When you invoke the
script, you then append the string -DatabaseServer $MyDatabaseServer to the
PowerShell command.

• Alternatively, you can just invoke the script as is, and while you run the script,
PowerShell prompts you for a value for Net Service, and you can then enter one of
the following:

• Enter the Net Service Name for this database if you have defined a Net Service
Name in a tnsnames.ora file and specified the location of that file in a TNS_ADMIN
environment variable.

• Enter the string %manual% to let the script prompt you for the following: Host
name, Port and Service name.

• Enter the actual connection string directly on a single line if you have more to
provide than just a host, port and service name. For example:

(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = myhost)(PORT =
1521))(CONNECT_DATA = (SERVICE_NAME = ora)))
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7. Type the following command to upgrade your Access Management database:

& '.\Upgrade Access Management database.ps1'

8. Follow the instructions in the PowerShell console to upgrade the database.

What to do next

If you encounter problems during the upgrade, restore your backup and try again. If your
second attempt fails as well, consult RWS Customer Support for assistance. Do not attempt
to fix the database.

Upgrading the Access Management service
Follow this process to upgrade the Access Management service to 15.1.

Before you begin
Before upgrading the Access Management service, you need to have first upgraded the
database.

To run PowerShell scripts for software, you require a machine that meets the following
requirements:

PowerShell
You require Microsoft Windows PowerShell 5.1. You can download Microsoft Windows
Management Framework 5.1, which includes Microsoft Windows PowerShell 5.1, from this
location: http://aka.ms/wmf5download 

Operating system
You require an operating system that supports both the required PowerShell software
and any software for the database you intend to install. As a general rule, ensure that the
latest (security) updates are installed on your operating system.

Microsoft .NET Framework
You require a .NET Framework version. The one to use depends on your Windows Server
operating system version:

• If you run Microsoft Windows Server 2022, you can use Microsoft .NET Framework
4.8.1. You can download Microsoft .NET Framework 4.8.1 from the following location:
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net481 

• If you run Microsoft Windows Server 2019 x64, you must use Microsoft .NET
Framework 4.8. You can download Microsoft .NET Framework 4.8 from the following
location: https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48 

Security
You need to be logged in as a user with sufficient security clearance. For example, to run
a script that installs a database, you must be logged in as a user with rights to create that
database.

The steps that follows represent a high-level process, which includes several tasks that are
individually explained in other topics. For details on the individual tasks, refer to the related
topics.
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Procedure
1. On the machine where the Access Management service is installed, locate the service's

appsettings. json file and back it up to a safe location.
2. Uninstall old Access Management service. Rename it, if needed.
3. From the Tridion Docs 15.1 installation media, copy the entire root-level folder Access

Management\ to a folder of your choice on the target machine.
4. Locate the new version of appsettings. json and merge in your changes from the

backed-up copy. If the backed-up file is encrypted, you will need to decrypt it first.
5. Install a new Access Management service that uses the upgraded database.

Results

The Access Management service upgrade is now complete.

Configuring custom IdPs in an upgraded Access
Management
After upgrading Access Management, check that your identity providers are properly
configured. In particular, ensure that any custom identity providers are configured for the
features you intend to use in the upgraded Tridion Docs environment.

About this task
If you plan on enabling the Metrics feature of Organize Space, the identity provider in the
upgraded Access Management must be configured to give access to the Tridion Docs Metrics
API.

• If you are using the Tridion Docs Identity Provider that comes with Access Management,
the upgrade process automatically updates IdP's services and roles to enable access as
a user. No further action should be necessary.

• If you are using a custom identity provider (IdP), follow this procedure to update the
IdP's services and roles.

Procedure
1. In your Tridion Docs environment, open Access Management.
2. Go to the Identity providers tab.
3. Open the identity provider and select Edit.
4. In the Access settings section, be sure the Global claim is selected in the list of the

claims.
5. In the Services and roles list, locate the section for the Tridion Docs Metrics API and

select the User role.
6. Select Save.
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Installing desktop client tools
You can choose to install desktop client tools (Authoring Bridge, Publication Manager,
Condition Manager and Content Importer) based on the role and responsibilities of the
user. The versions of the desktop clients tools must match the version of Content Manager
installed on the server.

Uninstalling deskop client tools (upgrade only)
If you are upgrading Content Manager, first uninstall your existing desktop client tools from
the Windows Settings, in the Apps & features screen. The specific names of the items
depend on the version from which you are upgrading, but will include the name of the
product and the strings "Condition Manager," "Content Importer," "Publication Manager,"
and "Connector" or "Authoring Bridge".

Installing the Authoring Bridge
The Authoring Bridge is used to access the repository using an authoring tool.

About this task

Choose the Authoring Bridge installer for the XML editor software that you are using (XMetaL
or Oxygen). The type and version of the editor you are using must be supported by the
installed version of Content Manager.

If an incompatible version of the .NET runtime framework is installed, the installer will install
a correct one after your validation.

The install package's names match the following format, one for each compatible XML
Editor:

• <date>.AuthoringBridge.<version>-XMetal-Connector.msi

• <date>.AuthoringBridge.<version>-oXygen-Connector.msi

The development kit's executable name matches the following format:

• <date>.AuthoringBridgeSDK.<version>.exe

Procedure
1. Double-click the Authoring Bridge install package, or Setup Wizard, and follow the

proposed list of steps. After you hit the Finish button, the installation is complete and
the Tridion Docs menu is now available in your authoring tool's menu bar.
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Results

When you first try to access the Repository from your authoring tool, you will be requested
to specify a user account in order to establish the connection.
For uninstall, be aware of the following:

• If you are using XMetaL on Windows, you must uninstall the Authoring Bridge before
uninstalling XMetaL.

• If the Authoring Bridge is uninstalled, the Tridion Docs menu will remain in the menu
bar, with all menu options greyed out. You must start XMetaL while pressing the CTRL key
in order to have XMetaL clean up the menu bar and remove the Tridion Docs menu.

Installing Publication Manager
The publication manager is used to create, modify, check the status of, and produce
publications in various formats.

About this task
If an incompatible version of the .NET runtime framework is installed, the installer will install
a correct one after your validation.

The install package's name matches the following format: <date>.PublicationManager.
<version>.msi

Procedure
1. Double-click the Publication Manager install package, or Setup Wizard, and follow the

proposed list of steps. After you hit the Finish button, the installation is complete and
Publication Manager is now available for you to use.

Installing Condition Manager
The Condition Manager is used to create and manage conditions for your publications.

About this task
If an incompatible version of the .NET runtime framework is installed, the installer will install
a correct one after your validation.

The install package's name matches the following format: <date>.ConditionManager.
<version>.msi

Procedure
1. Double-click the Condition Manager install package, or Setup Wizard, and follow the

proposed list of steps.
2. Select the Enable Synchronization option when proposed (on the tab where you specify

the installation folder). Content Manager can synchronize the set of conditions with
definitions from another system. Synchronization needs to be configured separately,
Enable Synchronization only makes the menu items available in the application.

3. After you hit the Finish button, the installation is complete and Condition Manager is
now available for you to use.
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Installing Content Importer
Content Importer helps you import content through Organize Space commands.

About this task
If an incompatible version of the .NET runtime framework is installed, the installer will install
a correct one after your validation.

The install package's name matches the following format: DATE.ContentImporter.
VERSION.msi, where DATE is a date and VERSION is the version of Content Importer.

Procedure
1. Double-click the Content Importer install package, or Setup Wizard, and follow the

proposed list of steps. After you hit the Finish button, the installation is complete.

After the Content Manager upgrade
After you complete the upgrade of your Content Manager server, perform a number of
tasks to help you verify the upgrade, and to configure the components that you have just
upgraded.

Upgrading your XML configuration versions
If you've upgraded from Tridion Docs 15 to Tridion Docs 15.1, the upgrade automatically
sets the versions of your XML configuration files to correct values for Tridion Docs 15.1. But
if you've upgraded from an earlier version than Tridion Docs 15, you need to set the versions
correctly yourself. This task explains how.

Procedure
1. Sign in to Organize Space as an administrator.
2. On the top tab level, select the Settings tab.
3. On the second tab level, select the XML Settings tab.
4. On the third tab level, select each XML configuration in turn and make sure that the

value of the version attribute in the root element is the value given below, then select
Save to apply your changes:

Name of XML configuration Value of root-level version attribute

Background Tasks 3.0

Change Tracker 1.0

Collective Spaces 1.1

Extensions 2.0

Inboxes 2.0

Publish Plug-ins 1.0
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Name of XML configuration Value of root-level version attribute

Reports 1.0

Statuses 3.0

Translations 2.1

Write Plug-ins 2.0

Upgrading your Inboxes configuration
Tridion Docs 15 introduced some changes to the XML of the configuration for Inboxes. If
you've upgraded Content Manager from a release earlier than Tridion Docs 15, transform
your existing inbox configuration XML from old format to new format by running a
Powershell script.

About this task

The script assumes to find your old inbox configuration XML file in the folder C:\InfoShare\
Web\ Author\ EnterViaUI\ . If you would like the conversion to occur in another folder, you
can edit the script to change the path.

Procedure
1. On your installation media, go to the folder __Resources\ InfoShareScripts\

Upgrade140xTo1500\.
2. Copy the script ConvertInboxConfiguration. ps1 to your Content Manager server

machine.
3. Run the Powershell script.

The script reads Admin.XMLInboxConfiguration. xml and creates a converted file
Admin.XMLInboxConfiguration. converted.xml in the same folder.

4. Replace your existing XML inbox configuration in the Content Manager database with
the contents of the converted file. You can do this in one of the following ways:

• In the new Organize Space user interface, go to Settings > XML Settings > Inboxes.
Clear the XML content you see, and paste the contents of
Admin.XMLInboxConfiguration. converted.xml into it. Then select Save to apply
the change.

• Write a script that replaces the XML in the database with the contents of
Admin.XMLInboxConfiguration. converted.xml, and run it.

Migrating metadata properties to the taxonomy
After the upgrade to Tridion Docs 15.1, you may want to migrate some LOV-based metadata
properties to the taxonomy.
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Before you begin

To perform this task, you must be a user who has the Taxonomy Management privilege.

About this task
As from Tridion Docs 15.1, Content Manager has a configuration file for taxonomies that, by
default, contains a simple preconfigured taxonomy. This taxonomy defines a number of
metadata properties, including "Product family name" and "Product release name."

"Product family name" and "Product release name" are also lists of values (LOVs) (found in
the dropdown under Settings > System > Lists of values in Organize Space. If you have used
these metadata properties in your implementation, you should now run a migration script
to make them part of the taxonomy, instead of lists of values.

Note: After you have completed the migration, you must republish all publications that
use the metadata fields being migrated in order for your changes to take effect.

Procedure
1. Access your Tridion Docs installation artifacts and go to the folder InfoShare\ App\

Database\InfoShareCM\Common\DatabaseIndependent\Examples\
CreateInternalTaxonomySyncWithLovs\.

2. Invoke the migration script MigrateToIshTaxonomies. ps1 as follows:

.\MigrateToIshTaxonomies.ps1 -WsBaseUrl "BASEURL" -OutputDir "OUTDIR"
-Mappings @{
"GOAL"=""
"AUDIENCE"=""
"PRODUCTFAMILY"="DPRODUCTFAMILYNAME"
"PRODUCTRELEASE"="DPRODUCTRELEASENAME"

}

where:

• BASEURL is the web service URL of Content Manager, for example,
https://ish.example.com/ISHWS/

• OUTDIR is a writable folder location to which the script can write its output, for
example, c:\Temp

The script runs and produces an output file in the output directory.
3. In Organize Space, go to Settings > XML Settings > Taxonomies.
4. Copy-paste the output of the migration script into the content area, overwriting the

content you see.
5. Select Save to apply your changes.
6. To take the existing values for the old "Product family name" and "Product release name

" metadata fields and set those values as the values of the corresponding new fields, in
the same folder, run the migration script UpdateMBFieldsWithConcepts. ps1.

7. Republish any publications that use the migrated metadata properties.
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Rebuilding the full text index
Rebuild the full text index if it is no longer synchronized with the current database, or after
a Content Manager upgrade on a new server for example. It should be done using Invoke-
ISHFullTextIndexMaintenance cmdlet available over ISHDeploy module.

Before you begin

• You need to run ISHDeploy cmdlets as an administrator for the application server

• The crawler service must be running.

• To learn how to access and use ISHDeploy, refer to the section on “” on page 0.

Note: We recommend that you rebuild the index outside regular business hours as the
initialization uses database resources. In addition, the index may take a while to rebuild
depending on the size of the repository.

Procedure
1. In a Powershell command shell, enter the following command:

Invoke-ISHFullTextIndexMaintenance -ISHDeployment $deployment
ISHDEPLOYMENT -Cleanup

to remove the existing index, where ISHDEPLOYMENT is the deployment you want to use.
(If you have only one deployment, you can omit the -ISHDeployment parameter and its
value.)

2. In a Powershell command shell, enter the following command:

Invoke-ISHFullTextIndexMaintenance -ISHDeployment $deployment
ISHDEPLOYMENT -ReIndex

to rebuild the full text index, where ISHDEPLOYMENT is the deployment you want to use.
(If you have only one deployment, you can omit the -ISHDeployment parameter and
its value.)

Verifying Microsoft SQL System Administration
role permissions
If you use Microsoft SQL Server as your database, then after upgrading Content Manager,
grant the isource user system administrator permissions. This ensures that the database
upgrade tool (DBUpgradeTool or DBUT) works properly.
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About this task
To allow DBUT to fully execute all necessary tasks to update your Microsoft SQL Server
database now and for each new release, follow the procedure below to ensure the database
user has the necessary permissions.

Procedure
1. Access the SQL Server Management Studio.

Windows 2012: To access the SQL Server Management Studio if not readily accessible,
use the Windows Powershell icon on the bottom toolbar then at the prompt type:
Ssms.exe.

Note: If prompted and required, connect to the server.

2. Under the folder for the MSSQL server in the left pane, open Security > Logins.
3. Right-click on the isource user and select Properties.

A Login Properties - isource window displays.
4. In the left pane of the Login Properties - isource window select Server Roles.
5. In the right pane for Server Roles select public and sysadmin.
6. Click OK.
7. Click File > Exit to exit and close the Microsoft Server Management window.

Running DBUpgradeTool for maintenance
After upgrading Content Manager, use DBUpgradeTool (DBUT) to perform an overall
verification of the database, to update database objects such as views, indexes, packages
and stored procedures, and to modify metadata structures.

Before you begin

• The isource database user must have the System Administrator privilege.

• The Content Manager server and Content Manager database must be available (up and
running), complete and correctly installed. The installation ensures that the upgrade
files and connections are in place to allow a successful upgrade.

• DBUT has exclusive access to the Content Manager database. That means that before
running the tool, you should stop all components and services, such as InfoShare
Crawler, on all servers.

Procedure
1. Sign in to the Content Manager application server as a Windows user with the

Administrator user role.
2. In Windows Explorer, go to the Content Manager installation directory, then go to \ App\

Setup\DBUpgradeTool\.
3. Run DBUpgradeTool.exe
4. Only if you use ADFS, use DBUT to configure the FishExternalID of the administrator
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user with a value such as domain\ username, for the user who has to sign in to the system
as administrator:
a. In DBUT, select option 1: Maintenance.
b. Select option 5: Append an user's external ID for initial STS sign-in.
c. Choose the installation and then fill in the appropriate value for the Content

Manager admin user.
5. If you performed an upgrade, select the DatabaseUpgrade option.
6. Press Enter to respond to a series of questions; the default options are sufficient for the

following questions:

• Select your recently installed project (thereby selecting the database location and
user, upgrade script paths, version and so on).

• Default for the application.
The result is an upgrade from an older or same version to the installed version when
applicable. The application pool needs to be restarted after a DBUT run.

Troubleshooting DBUpgradeTool
You may encounter issues during DBUT execution for database upgrade purposes.

Execution is interrupted
If the DBUT suddenly dies, it results in a hanging database upgrade logged in to the
database. All other attempts to upgrade will fail since only one upgrade process is
permitted to run at a time.

To force an undo of a hanging update, execute DBUT then select Maintenance >
Terminate and your current project.

Current user isource warnings
The following warnings can occur in DBUT:

• WARNING: The current user "isource" does not have permission to disable
the standard database job for InfoShare.

• WARNING: The current user "isource" does not have permission to install
the standard database job for InfoShare. Ask a System Administrator to
manually execute ISH_CreateStandardInfoShareJob.sql and
ISH_EnableStandardInfoShareJob.Sql to create and enable the standard
InfoShare job!

• WARNING: The current user "isource" does not have permission to enable the
standard database job for InfoShare.

These warnings are returned when the user executing DBUT has not enough rights to
access/create database jobs.

• Creating a database job requires a database administrator to execute CD-Package\
Database\InfoshareCM\Common\<SQLServerVersion>\Create\
ISH_CreateStandardInfoShareJob.sqland CD-Package\Database\InfoshareAM\
Common\<SQLServerVersion>\Create\ISH_CreateStandardInfoShareJob.sql

• Enabling a database job requires a database administrator to execute CD-Package\
Database\InfoshareCM\Common\<SQLServerVersion>\Create\
ISH_EnableStandardInfoShareJob.Sqland CD-Package\Database\InfoshareAM\
Common\<SQLServerVersion>\Create\ISH_EnableStandardInfoShareJob.Sql
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Requesting assistance
In case you need to request assistance, you need to provide the following information:

• A screenshot of the failed execution of DBUpgradeTool.

• The log file: \App\Setup\DBUpgradeTool\DBUpgradeTool.log

Installing ISHDeploy and ISHRemote
When upgrading to Tridion Docs 15.1, you need to install the ISHDeploy and ISHRemote
PowerShell modules on the Content Manager application server. The modules are needed
to run the scripts delivered with Tridion Docs.

Before you begin

• Microsoft Windows PowerShell 5.1 (part of Windows Management Framework 5.1)
To quickly check your installed PowerShell version, execute the following script:

$PSVersionTable

If your operating system has an earlier version of PowerShell, then you need to install
PowerShell 5.1.

• You must be logged on as an administrator user to perform this task.

About this task
ISHDeploy is a PowerShell module that enables the code as configuration concept for
Tridion Docs. You can use ISHDeploy cmdlets for all basic setup operations, and for many
advanced configuration tasks. Although manual configuration is still available, we
recommend you use ISHDeploy for improved simplicity and safety. ISHDeploy also gives you
access to automation.

ISHRemoteis a PowerShell module that enables business automation for Tridion Docs. It's
constructed close to the Web Services API to:

• allow business logic automation, ranging from triggering publishing into the continuous
integration pipeline to legacy data correction, up to provisioning

• showcase code examples and API best practices

All scripts delivered with Tridion Docs, such as those in the ..\ DatabaseIndependent\
Examples\ folder, expect ISHDeploy and ISHRemote to be installed. Install both of the
PowerShell modules using the installation script delivered with your installation package or
downloaded from the PowerShell Gallery (always the latest).

Procedure
1. On the Content Manager application server, open a PowerShell prompt.
2. Run one of the following PowerShell scripts:

InstallPowerShellLibrariesFromLocal.ps1
This script is provided in the local NuGet packages delivered with the product. Get it
from the following folder: c:\InfoShare\App\Setup\PowerShell\Repository

To run the script, use the following command:

2 Upgrading Content Manager

58 Tridion Docs Content Manager upgrade guide

https://powershellgallery.com/


& '.\InstallPowerShellLibrariesFromLocal.ps1'

InstallPowerShellLibrariesFromPSGallery.ps1
This script always installs the latest versions of ISHDeploy and ISHRemote. You can
download from PowerShell Gallery .

To run the script, use the following command:

& '.\InstallPowerShellLibrariesFromPSGallery.ps1'

Both ISHDeploy and ISHRemote are now installed.

Manually creating or updating XML
configurations (upgrade only)
You must make your XML configurations work with the current release. You only need to
perform this task if you did not receive a fully prepared database dump-backup file for your
upgrade.

About this task
The following table lists the XML configurations for Content Manager. For each configuration,
it lists the filename of the configuration (located on the server in the Web\ Author\
EnterViaUI\ subdirectory of the Content Manager home directory) and the name of the
corresponding screen under Settings > XML Settings. Perform the steps below for each
XML configuration.

Configuration file Settings > XML Settings screen

Admin.XMLAIAssistantConfiguration.xmlAI Assistant

Admin.XMLBackgroundTaskConfiguration.xmlBackground Tasks

Admin.XMLChangeTrackerConfig.xml Change Tracker

Admin.XMLCollectiveSpacesConfiguration.xmlCollective Spaces

Admin.XMLDeleteObjPluginConfig.xml Delete Plug-ins

Admin.XMLExtensionConfiguration.xml Extensions

Admin.XMLInboxConfiguration.xml Inboxes

Admin.XMLMetricsConfiguration.xml (none)

Admin.XMLPublishPluginConfiguration.xmlPublish Plug-ins

Admin.XMLReportConfiguration.xml Reports

Admin.XMLStatusConfiguration.xml Statuses
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Configuration file Settings > XML Settings screen

Admin.XMLTaxonomyConfiguration.xml Taxonomies

Admin.XMLTranslationConfiguration.xmlTranslations

Admin.XMLWriteObjPluginConfig.xml Write Plug-ins

Note: RWS recommends that you perform this task before starting any services on your
upgraded system.

Procedure
1. Sign in to Organize Space as a user with administrator-level credentials.
2. On the top tab level, select the Settings tab.
3. On the second tab level, select the XML Settings tab.
4. Select the third-level tab you intend to modify.
5. Do one of the following:

• If this is an XML configuration that did not yet exist in the Tridion Docs release from
which you are upgrading, copy-paste the contents of the XML configuration file on
the server over the contents you see on the screen.

• If this is an XML configuration that already existed in the Tridion Docs release from
which you are upgrading, and you did not modify this XML configuration, copy-paste
the contents of the XML configuration file on the server over the contents you see
on the screen.

• If this is an XML configuration that already existed in the Tridion Docs release from
which you are upgrading, and you did modify this XML configuration, perform a
three-way merge between your old out-of-the-box configuration file, your old
customized configuration file, and the new out-of-the-box configuration file. That is,
check which customizations you applied to the old configuration file, and reapply
those customizations to the new configuration file.

6. Select Save to apply your changes.
The configuration file is validated and some corrections are made. (For example, a
@version attribute is added.)

Note: If you encounter validation errors when submitting the XML configuration for
Statuses, remove all statuses in the status definitions with value "Not found as LOV
Value"; that is, any XML statuses with the format <Status Elm="STATUSNAME" value="Not
found as LOV Value"/>, where STATUSNAME is the name of a status.

7. Return to step 4 to continue with the next XML configuration.
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Checking translation services roles and
privileges
An active TRANSLATORSERVICE role is necessary for translation services
(TranslationOrganizer, TranslationBuilder) to operate. This role is part of the out-of-the-box
settings for Content Manager 10.0.0 and later. As from Tridion Docs 15. the user used for
translation services must have an "Administrator" user role, or be a part of any other role that
as "System Administrator" privilege or "Translation Mangement" privilege. In case
TRANSLATIONSERVICE role needs to be created with all status transitions, follow the
procedure:

Procedure
1. Sign in to Organize Space as a user with administrator-level credentials.
2. On the top tab level, select the Settings tab.
3. On the second tab level, select the Users tab.
4. On the third tab level, select the User Roles tab.
5. Do one of the following:

• If TRANSLATORSERVICE is part of the list, select it and select Properties from the
button toolbar. In the dialog that opens, make sure that Active is selected.

• If TRANSLATORSERVICE is not part of the list, create it by selecting New from the
button toolbar and, in the dialog that opens, specifying TRANSLATORSERVICE in the
Name field. Then select OK to close the dialog and apply your changes.

6. On the second tab level, select the XML Settings tab.
7. On the third tab level, select the Statuses tab.
8. Check that the following status transitions are configured as <FromStatus> sections in

the <Transitions> section of the XML you see:

From Status To Status User Role

To be translated In translation TRANSLATORSERVICE

In translation Translation in review TRANSLATORSERVICE

In translation Translation approved TRANSLATORSERVICE

Translation in review Translation approved TRANSLATORSERVICE

Translation in review Translation rejected TRANSLATORSERVICE

Translation rejected In translation TRANSLATORSERVICE

If you see XML for all these transitions, then no other action is required.
9. However, if any of these transitions are not part of the list, create them by adding the

following XML fragment within the <Transitions> section:

<FromStatus ref="FROMSTATUS" userrole="TRANSLATORSERVICE">
<ToStatus ref="TOSTATUS" />

</FromStatus>
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where FROMSTATUS is the item in the From Status column above for the missing
transition, and TOSTATUS is the item in the To Status column above for the missing
transition.

10. If you made any changes, select Save to commit those changes.

Enabling Content Manager user interfaces and
features
After upgrading Content Manager, you can individually enable the individual user interfaces
and subfeatures that are part of Collective Spaces.

Enabling Draft Space
Enable Draft Space by running an ISHDeploy command and setting the Enable Draft Space
flag in the Organize Space user interface.

Before you begin

To learn how to access and use ISHDeploy, refer to the section on “” on page 0.

About this task
Draft Space is one of the two applications that are grouped under the name Collective
Spaces.

Procedure
1. In a Powershell command shell, enter the following command:

Enable-ISHUICollectiveSpaces -DraftSpace -ISHDeployment ISHDEPLOYMENT

where ISHDEPLOYMENT is the deployment you want to use. (If you have only one
deployment, you can omit the -ISHDeployment parameter and its value.)

2. Enable Draft Space from the Organize Space user interface by doing the following:
a. On the top tab level, select the Settings tab.
b. On the second tab level, select the System tab.
c. On the third tab level, select the Default Settings tab.
d. In the Optional features area, select Draft Space (paid).
e. Select Save to apply your changes.
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Results
You now have access to Draft Space for web browser-based content authoring.

Enabling Review Space
Enable Review Space by running an ISHDeploy command and setting the Enable Review
Space flag in the Organize Space user interface.

Before you begin

To learn how to access and use ISHDeploy, refer to the section on “” on page 0.

About this task
Review Space is one of the two applications that are grouped under the name Collective
Spaces.

Procedure
1. In a Powershell command shell, enter the following command:

Enable-ISHUICollectiveSpaces -ReviewSpace -ISHDeployment ISHDEPLOYMENT

where ISHDEPLOYMENT is the deployment you want to use. (If you have only one
deployment, you can omit the -ISHDeployment parameter and its value.)

2. Enable Review Space from the Organize Space user interface by doing the following:
a. On the top tab level, select the Settings tab.
b. On the second tab level, select the System tab.
c. On the third tab level, select the Default Settings tab.
d. In the Optional features area, select Review Space (paid).
e. Select Save to apply your changes.

Results
You now have access to Review Space for web browser-based content reviewing.

Enabling Document History for Draft Space
Enable Document History for Draft Space by running an ISHDeploy command and setting
the Enable Draft Space Document History flag in the Organize Space user interface.

Before you begin

In order to be able to use Document History for Draft Space, Draft Space must be enabled.

To learn how to access and use ISHDeploy, refer to the section on “” on page 0.
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About this task
Document History is a Collective Spaces feature. It lets you trace the history of each
document in detail, but you should only enable it if you have the required license for this
feature.

Procedure
1. In a Powershell command shell, enter the following command:

Enable-ISHUICollectiveSpaces -DocumentHistoryForDraftSpace
-ISHDeployment ISHDEPLOYMENT

where ISHDEPLOYMENT is the deployment you want to use. (If you have only one
deployment, you can omit the -ISHDeployment parameter and its value.)

2. Enable Document History for Draft Space from the Organize Space user interface by
doing the following:
a. On the top tab level, select the Settings tab.
b. On the second tab level, select the System tab.
c. On the third tab level, select the Default Settings tab.
d. In the Optional features area, select Draft Space document history (paid).
e. Select Save to apply your changes.

Results
You now have access to Document History for web browser-based content authoring. The
Show Changes option is now enabled for documents in Draft Space.

Enabling Document History for Review Space
Enable Document History for Review Space by running an ISHDeploy command and setting
the Enable Review Space Document History flag in the Organize Space user interface.

Before you begin

In order to be able to use Document History for Review Space, Review Space must be
enabled.

To learn how to access and use ISHDeploy, refer to the section on “” on page 0.

About this task
Document History is a Collective Spaces feature. It lets you trace the history of each
document in detail, but you should only enable it if you have the required license for this
feature.
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Procedure
1. In a Powershell command shell, enter the following command:

Enable-ISHUICollectiveSpaces -DocumentHistoryForReviewSpace
-ISHDeployment ISHDEPLOYMENT

where ISHDEPLOYMENT is the deployment you want to use. (If you have only one
deployment, you can omit the -ISHDeployment parameter and its value.)

2. Enable Document History for Review Space from the Organize Space user interface by
doing the following:
a. On the top tab level, select the Settings tab.
b. On the second tab level, select the System tab.
c. On the third tab level, select the Default Settings tab.
d. In the Optional features area, select Review Space document history (paid).
e. Select Save to apply your changes.

Results
You now have access to Document History for web browser-based content reviewing. The
Show Changes option is now enabled for documents in Review Space.

Setting the Collective Spaces URL for your accounts
Before you begin

As of SDL Tridion Docs 14 SP2, Publication Manager users can copy the Draft Space URL or
Review Space URL of each topic to the clipboard. To enable this feature for an account, the
Collective Spaces URL must be configured in the account settings.

Procedure
1. Start Publication Manager.
2. Select Tools > Accounts.
3. In the Repository tab, find the Collective Spaces address property.
4. Fill in the Collective Spaces URL and select OK.

Enabling services
After the upgrade has completed, services will not start automatically, since the database is
not guaranteed to be in the right state until you run the DBUT tool. Also, you might decide
not to start some services on the specific installation depending on the server role. To enable
typical services, you can locate and run the Enable-DefaultServices. ps1 script.
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Before you begin

• The ISHDeploy module is installed.

• DBUT completed successfully.

• The Administrator setup completed successfully.

• The TRANSLATORSERVICE role is created and the translation status transitions have
been assigned to it.

• You have System Administrator rights.

Procedure
1. Run the script \App\Setup\Manage\Enable-DefaultServices.ps1.

Typical services are started and the startup type is set to "Automatic (Delayed Start)".
The following are some of the typical services:

• Trisoft InfoShare

• Crawler One

• Trisoft InfoShare SolrLucene

• Trisoft InfoShare BackgroundTask One

• Trisoft InfoShare TranslationBuilder One

Configure Security Token Service for
authenticating WCF .SVC web services
(deprecated)
The WCF .SVC web services require that you configure a Security Token Service (STS) for
authentication, which uses ISHSTS as the default identity provider.

Using ISHDeploy is an alternative to the manual tasks described in this section.

Security Token Service for externalized authentication and Single Sign-On is deprecated as
of Tridion Docs 15. Prior to Tridion Docs 15, the Content Manager user interfaces also used
Security Token Service; however, these applications now use Tridion Access Management. At
this time, only the WCF .SVC web services continue to use the deprecated Security Token
Service.

Web Services requirements for Security Token Service
The WCF .SVC web services (ISHCM) require identifiers and certificates to configure Security
Token Service.
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Profile
WCF .SVC web services rely on an Active profile to do Federated Authentication. The profile
refers to SOAP-based web services implementing the WS Trust protocol. Token encryption is
mandatory.

Identifiers and encryption certificates
The web service ISHCM expects specific identifiers in combination with an encryption
certificate to be configured on a Security Token Service.

The encryption certificate is the public key of the certificate referenced through the
servicecertificatethumbprint input parameter.

The identifiers are as follows:

• https://example.com/ISHWS/

• https://example.com/ISHWS/Wcf/API25/Application.svc

• https://example.com/ISHWS/Wcf/API25/Baseline.svc

• https://example.com/ISHWS/Wcf/API25/DocumentObj.svc

• https://example.com/ISHWS/Wcf/API25/EDT.svc

• https://example.com/ISHWS/Wcf/API25/EventMonitor.svc

• https://example.com/ISHWS/Wcf/API25/Folder.svc

• https://example.com/ISHWS/Wcf/API25/ListOfValues.svc

• https://example.com/ISHWS/Wcf/API25/MetadataBinding.svc

• https://example.com/ISHWS/Wcf/API25/OutputFormat.svc

• https://example.com/ISHWS/Wcf/API25/PublicationOutput.svc

• https://example.com/ISHWS/Wcf/API25/Search.svc

• https://example.com/ISHWS/Wcf/API25/Settings.svc

• https://example.com/ISHWS/Wcf/API25/TranslationJob.svc

• https://example.com/ISHWS/Wcf/API25/TranslationTemplate.svc

• https://example.com/ISHWS/Wcf/API25/User.svc

• https://example.com/ISHWS/Wcf/API25/UserGroup.svc

• https://example.com/ISHWS/Wcf/API25/UserRole.svc

• https://example.com/ISHWS/Wcf/API20/Application.svc

• https://example.com/ISHWS/Wcf/API20/DocumentObj.svc

• https://example.com/ISHWS/Wcf/API20/EDT.svc

• https://example.com/ISHWS/Wcf/API20/EventMonitor.svc

• https://example.com/ISHWS/Wcf/API20/Folder.svc

• https://example.com/ISHWS/Wcf/API20/MetaDataAssist.svc

• https://example.com/ISHWS/Wcf/API20/OutputFormat.svc

• https://example.com/ISHWS/Wcf/API20/Publication.svc

• https://example.com/ISHWS/Wcf/API20/PublicationOutput.svc
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• https://example.com/ISHWS/Wcf/API20/Reports.svc

• https://example.com/ISHWS/Wcf/API20/Search.svc

• https://example.com/ISHWS/Wcf/API20/Settings.svc

• https://example.com/ISHWS/Wcf/API20/Workflow.svc

• https://example.com/ISHWS/Wcf/API/Application.svc

• https://example.com/ISHWS/Wcf/API/ConditionManagement.svc

ISHSTS with Windows Authentication
You need to perform several settings before ISHSTS can provide Windows Authentication.
Both server and SQL server database must be properly configured. You can either make
these settings manually or use the scripts provided with the package.

ISHSTS is automatically configured through the installation.

InstallTool creates an application pool such as TrisoftAppPoolISHSTS based on the input
parameter infosharestswebappname. The application pool is assigned an identity based on
the input parameter osuser. This user is responsible for hosting the endpoints provided by
ISHSTS

For Windows Authentication endpoints to work, the following changes based on the
requirements of Service Principal Names defined in the Active Directory must be made,
either manually or through a script.

Note: The following needs to be applied per installation server and are valid only for
deployments that do not include network balanced front end servers

Application pool identity
A change of the application pool identity in order to use the integrated
ApplicationPoolIdentity. This changes the user who hosts the endpoints to an account
that the correct Service Principal Names is assigned to. The expected Service
Principal Names are

• http/baseurl

• host/baseurl

Note: The new user is identified locally as IIS AppPool\infosharestswebappname and it
requires certain permissions to access resources. When this user accesses network
resources it is identified as the computer account Domain\ Computer$ where the Domain
and Computer are netbios based. e.g. TESTDOMAIN\SERVER01$

Read permissions
Read permissions to the token signing certificate's private key are assigned to the IIS
AppPool\infosharestswebappname. The token signing certificate in ISHSTS is configured
through the InstallTool parameterissuercertificatethumbprint

Read/write permissions to the three target installation paths defined in the input
parameters are assigned to the IIS AppPool\infosharestswebappname:

• webpath

• datapath
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• apppath

Integrated authentication
If the database is SQL Server and the connection string utilizes integrated authentication
then we grant the computer account permissions to the database.

The only permission required is SELECT

Configure application server for Windows Authentication

Here is how you execute the script that configures the server for ISHSTS with Windows
Authentication.

Before you begin

This task requires a PowerShell session that with Execution Policy set to Unrestricted.

If it is not set, you need to set it permanently by executing the following:

Set-ExecutionPolicy Unrestricted

The task requires administrator privileges.

Note: InstallTool has already transformed the script based on the input parameters.

Procedure
1. Locate the PowerShell script SDL.ISH-ISHSTS-Configure for Windows

Authentication.ps1 in the folder \InfoShare\App\Setup\STS\ISHSTS\Scripts
2. Open PowerShell with elevated administrator privileges. Run As Administrator.

If the PowerShell session is not running with administrator privileges, the script will
launch a new session and administrator privileges will be requested to the user.

3. Navigate to the script folder \InfoShare\App\Setup\STS\ISHSTS\Scripts
a. cd \InfoShare\App\Setup\STS\ISHSTS\Scripts

4. Execute script SDL.ISH-ISHSTS-Configure for Windows Authentication.ps1
a. .\SDL.ISH-ISHSTS-Configure for Windows Authentication.ps1

PowerShell session

cd \InfoShare\App\Setup\STS\ISHSTS\Scripts
& '.\SDL.ISH-ISHSTS-Configure for Windows Authentication.ps1'
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Configuring the Content Manager SQL Server database for Windows
Authentication

Here is how you execute the script that allows the server's computer account to access a
SQL Server database.

Before you begin

The task applies for SQL Server database when the connection string used integrated
authentication.

The task requires sysadmin rights on the SQL Server.

Note: InstallTool has already transformed the script based on the input parameters.

Procedure
1. Locate the script GrantComputerAccountPermissions. sql in the \ InfoShare\ App\

Database\ InfoShareCM\ Common\ folder. Depending on your version of SQL Server:

• For SQL Server 2019, the script path is \InfoShare\AppPROJECTSUFFIX\ Database\
InfoShareCM\Common\SQLServer2019\Tools\GrantComputerAccountPermissions.
sql

• For SQL Server 2017, the script path is \InfoShare\AppPROJECTSUFFIX\ Database\
InfoShareCM\Common\SQLServer2017\Tools\GrantComputerAccountPermissions.
sql

where PROJECTSUFFIX is a suffix string.
2. Execute the script on the target SQL server instance.

SQL Server script that grants necessary permissions

If the target database is INFOSHAREDB and the computer account is TESTDOMAIN
\SERVER01$ then the script looks like this:

USE [master]
GO
CREATE LOGIN [TESTDOMAIN\SERVER01$] FROM WINDOWS WITH DEFAULT_DATABASE=
[INFOSHAREDB]
GO
USE [INFOSHAREDB]
GO
CREATE USER [GLOBAL\MEDEVASARAFIA01$] FOR LOGIN [TESTDOMAIN\SERVER01$]
GO
USE [INFOSHAREDB]
GO
GRANT SELECT TO [TESTDOMAIN\SERVER01$]
GO
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Verifying the upgrade
Conduct some testing to verify critical parts of your upgraded system.

Verifying URLs
If your environment includes reverse proxy servers, after you install Content Manager, you
need to check that certain URLs are accessible.

Procedure
1. Using an internet browser, ensure that you can reach the following URLs:

• BaseURL/ISHWS/Application.asmx?wsdl

• BaseURL/ISHWS/Application.asmx?disco where BaseURL is the value specified for the
baseurl parameter, and ISHWSWS is the value specified for the infosharewswebappname
parameter. These parameters are set in the inputparameter. xml file that is used by the
Content Manager installer.

2. If you cannot access the URLs, verify that the reverse proxy servers are correctly
configured. See the documentation for the reverse proxy servers.

Verify read access to the database by viewing an inbox
To verify read access to the database, request to view an inbox in Organize Space.

Procedure
1. Open an internet browser and enter the address for Organize Space.

Note: The Organize Space address is a combination of two parameter values in the
parameters in the inputparameters. xml file, baseurl and infosharecswebappname,
followed by the string /OrganizeSpace/

For example, if:

<param name="baseurl">
<currentvalue>https://example.corp</currentvalue>

and

<param name="infosharecswebappname">
<currentvalue>ISHCS</currentvalue>

then the URL is:

https://example.corp/ISHCS/OrganizeSpace/

Enter a Content Manager username and password. If you are not sure about the
login/password and you imported the default database you can use admin/admin to
login.

2. On the top tab level, select the Content tab.
3. On the second tab level, select the Inbox tab.
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4. In the left pane, select an inbox. For example, select Reviewer.
If no objects are in the inbox, an empty inbox is displayed; There are no items to show
is reported in the content pane.
If there are objects in the inbox, a list of objects is displayed in the content pane.

Verify read and write access to the database by creating a
folder
Create, modify, and delete actions are handled through transactions and verifies read and
write access to the database.

Procedure
1. Sign in to Organize Space as an existing user, for example as the administrator user.
2. On the top tab level, select the Content tab.
3. On the second tab level, select the Structured Content tab.
4. Select the General node and select Add new > Folder.

An Add new folder dialog opens.
5. Enter a name in the Folder Name field. For example, enter the folder name Test.
6. Under Content type, select None.
7. Select OK.

The folder is created an displayed in the left pane.

What to do next
You can remove the test folder by selecting it in the list and then selecting Delete in the
button toolbar. You are asked to confirm the delete action, select Delete to confirm and
delete the folder.

Creating an account and connecting to the Repository
Before you can use Content Importer, you need to set up your user account. If you installed
Content Importer on a system where Publication Manager is already installed, the user
account settings are recognized.

Before you begin

You must create the user account and configure the connection to the Repository to allow a
user to connect and access data in the Content Manager Repository. Use this procedure to
create a new user account for testing purposes.

To create the account and connect to the Repository, you need the URL of the Content
Manager web services.
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Procedure
1. In Content Importer, select Create an account.

The account window is displayed.
2. Enter an Account Name and the URL of the Content Manager Web Service.
3. Select Next.
4. If necessary, select the Authentication Method.
5. Enter the username and password.

Check Remember password if you do not want to enter the information each time you
use the application.

6. Select Next.
Content Manager validates the account and synchronizes files.

Running a client tool
When started, the client tools verify availability of the synchronization website and web
services.

Before you begin

• A desktop client workstation must be installed with the client tools. If not done, refer to
the section for installing desktop clients.

• The client tool must be configured with a user login and account.

• To fully test the client, the database should contain data.

Procedure
1. If necesssary, create an account and connection to the repository.
2. Start a client tool such as Publication Manager, Condition Manager or Authoring Bridge

from the Start menu or desktop shortcut.

If you can view and access the repository through the client tool, and can view or preview
a topic in the repository then web services, synchronization, and network availability
have been successfully verified.

Testing publishing
You can test the publish functionality if your database contains topics, maps and
publications, and it is configured to render an output type.
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Before you begin

If your database is not configured to render an output, refer to the Content Manager
Information Portal documentation for information about adding output formats.

Procedure
1. Sign in to Organize Space as an existing user, say, the administrator.
2. On the top tab level, select the Content tab.
3. On the second tab level, select the Structured Content tab.
4. In the folder tree, navigate to a folder that contains a publication you want to pubish.
5. In the list, double-click the publication.

A detail view of the publication appears.
6. Expand the version of the publication that you want to publish, and select language and

output for the publication version.
7. Select Publish in the button toolbar at the top.

A dialog reports that publishing has started, and invites you to see event details.
8. To display progress, select View event details or select Refresh in the button toolbar

above the list.
When viewing event details, verification is complete when the Event Description is
Publish Process ended and the status says SUCCESS.

Executing the full text search
You can test the search functionality if the database contains content.

Procedure
1. Sign in to Organize Space.
2. On the top tab level, select the Content tab.
3. On the second tab level, select the Search tab.
4. Think of a word that frequently occurs in your content, enter that word in the Search

for field and press Enter (or select Apply).
If there is no search result, verify if a rebuild of the full-text-index collection is required.
Note that the full-text-index collection is not immediately available after installation since
it takes some time to build.

Verifying customer specific components
If you requested customizations of the out-of-the-box Content Manager software, a check
that they were delivered is recommended at this time.

2 Upgrading Content Manager

74 Tridion Docs Content Manager upgrade guide



About this task
Customizations of the delivered software may be, for example, PDF stylesheets, extra
metadata, or extra development to integrate with other systems such as SDL-TMS, PLMs,
SingleSignOns.

If you contracted for additional customizations, check that they were delivered and
functioning as required.

Advanced topics for upgrade
These advanced topics deal with firewalls and blocked ports.

Firewalls and blocked ports
There is a variety of possibilities regarding network and firewall configurations. Only some
of typical firewall configurations are described. A user knowledgeable about networking can
infer the required ports and protocol settings needed for more complex configurations.

Note: The following description is intended to guide you in your network and firewall
configuration. Its intention is not to be a complete how-to guide for setting up firewalls.
Several settings are subject to change in newer software versions. Be certain to refer to the
latest reference materials.

Network configuration using a single firewall
The first firewall is located between the Internet and the internal network

This is the first line of protection from the world wide web. All information passed through
the Content Manager web sites or web services are based on the HTTPS protocol.

The techniques described in the section for HTTPS (SSL) could be required depending on the
task of the Content Manager server.

Network configuration using two firewalls
The first firewall is located between the Internet and the DMZ as described above and the
second is located between the DMZ and the intranet

The second line of protection protects servers which are open to the general public from
the more critical company intranet servers. The zone between the first and second line of
protection is also called the DMZ (DeMilitarized Zone).

The following techniques could be required depending on the task of the Content Manager
server

• SMTP - when SMTP communication is required

• Database engines

• Microsoft SQL Server access is required

• Oracle database access is required
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• HTTP(S)

SMTP
Ports and protocols used by the Simple Mail Transfer Protocol (SMTP).

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions across the
internet. Formally SMTP is defined in RFC 821 (STD 10) as amended by RFC 1123 (STD 3)
chapter 5. The protocol used today is also known as ESMTP, and it is defined in RFC 2821.

Used by:

• Content Manager Publishing components

• Content Manager Author components

Settings:

What Protocol Port Direction

SMTP TCP 25 IN/OUT

For more information, refer to:

• http://msdn2.microsoft.com/en-us/library/ms942998.aspx 

• http://en.wikipedia.org/wiki/SMTP 

Microsoft SQL Server ports
Ports and protocols used by Microsoft SQL Server database engine (SQLServer).

About this task
Microsoft SQL Server is a relational database management system (RDBMS) produced by
Microsoft. Its primary query language is Transact-SQL, an implementation of the ANSI/ISO
standard Structured Query Language (SQL) which is used by Microsoft. You need to allow
distant users to connect to the SQL server so they can address it their queries.

SQL Server is used by:

• Content Manager End User components;

• Content Manager Author components;

• Content Manager Database.

Note: The first step of this procedure is sufficient in most cases. Go through the other steps
if you encounter any issue.
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Procedure
1. Enable remote connections to your SQL Server.

a. Open SQL Server Management Studio.
b. Right-click your server's name and select Properties.
c. Tick the checkbox Allow remote connections to this server.
d. Select OK.

Microsoft SQL Server by default uses TCP 1433 but this can be changed using SQL Server
Enterprise Manager or the database Management Studio.

2. Enable TCP/IP.
a. Open the SQL Server Configuration Manager.
b. In SQL Server Network Configuration select Protocols for [yourServerInstance].
c. In the right-hand pane, make sure that TCP/IP is Enabled.

3. Open the 1433 port in your firewall.
a. In the SQL Server Configuration Manager, right-click TCP/IP and select Properties.
b. Select the IP Addresses tab and make sure the TCP Port for IP1 is 1433.

4. If you are using a named instance, create an extra rule in your firewall with the port
1434.

Note: For a named SQL Server instance (e.g. [yourServerInstance]\ SQL2012SP2), the
firewall needs an extra rule on the UDP protocol with the specific port 1434. Without this
rule the system will return the exception error: 26 - Error Locating Server/
Instance Specified.

a. Display the firewall advanced settings by navigating to Control Panel > System
and Security > Windows Firewall > Advanced settings.

b. Select Inbound Rules in the left-hand pane, then click New Rule in the right-hand
pane.

c. In the New Inbound Rule Wizard, Rule Type step, select Port.
d. Protocols and Ports step, select UDP and set Specific local ports to 1434.
e. Action step, select Allow the connection.
f. Profile step, tick the Domain checkbox.
g. Name step, enter a name for this rule, e.g. Named instance port 1434.
h. Select Finish.

What to do next
For more information, refer to:

• http://support.microsoft.com/kb/287932 

• http://msdn.microsoft.com/en-us/library/ms942998.aspx 
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Oracle ports and protocols
Ports and protocols used by Oracle.

Oracle Database or simply Oracle is a relational database management system (RDBMS)
software product released by Oracle Corporation that has become a major feature of
database computing.

Used by:

• Content Manager End User components

• Content Manager Author components

• Content Manager Database

The Oracle database server communicates with the Content Manager application server
using a port, so make sure this port is opened IN/OUT in your firewall. The port by default is
1521.

What Protocol Port Direction

Listener
(runs on the
database server)

TCP 1521 (default) IN/OUT

HTTPS (SSL)
Ports and protocols used by Microsoft Internet Information Server (IIS).

HTTPS is a URI scheme used to indicate a secure HTTP connection. It is syntactically identical
to the http:// scheme normally used for accessing resources using HTTP. The https: URL
indicates that HTTP is to be used but with a different default TCP port (443) and an additional
encryption/authentication layer between the HTTP and TCP.

HTTPS is not a separate protocol, but refers to the combination of a normal HTTP interaction
over an encrypted Secure Sockets Layer (SSL). An https: URL may specify a TCP port. If it
does not, the connection uses port 443.

Used by:

• Content Manager End User Website

• Content Manager Author Website

• Content Manager WebServices

Settings:

What Protocol Port Direction

HTTPS TCP 443 IN/OUT
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Tridion Docs products include open source or similar third-party software.

@ant-design/cssinjs 
Component level cssinjs solution used in ant.design. It's a subset of Emotion with design
token logic wrapper.

@ant-design/icons 
The abstract trees of the Ant Design SVG icons.

@ant-design/icons-svg 
The abstract node of the Ant Design SVG icons.

@ant-design/react-slick 
Carousel component built with React. It is a react port of slick carousel

@emotion/hash 
A MurmurHash2 implementation

@emotion/is-prop-valid 
Check whether a prop is valid for HTML and SVG elements

@emotion/unitless 
An object of css properties that don't accept values with units

@ljharb/through 
Easy way to create a Stream that is both readable and writable.

@monaco-editor/react 
Monaco Editor for React

@popperjs/core 
Tooltip & Popover Positioning Engine

@rc-component/context 
React way perf context selector

@rc-component/mini-decimal 
A mini decimal calculator which only supports add, multi or compare operation for mini
bundle size.

@rc-component/mutate-observer 
MutateObserver for React.

@rc-component/portal 
React 18 supported Portal Component.

@rc-component/tour 
React 18 supported Tour Component.

@types/hoist-non-react-statics 
This package contains type definitions for hoist-non-react-statics

@types/prop-types 
This package contains type definitions for prop-types
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@types/react 
This package contains type definitions for react

@types/scheduler 
This package contains type definitions for scheduler

@types/stylis 
This package contains type definitions for stylis

@types/use-sync-external-store 
This package contains type definitions for use-sync-external-store

7zip 
Is a file archiver with a high compression ratio. 7-zip is delivered under the GNU LGPL
License.

7zip SFX Modified Module
The SFX Modified Module is a plugin for creating self-extracting archives. It is compatible
with three compression methods (LZMA, Deflate, PPMd) and provides an extended list of
options. Reference website http://7zsfx.info/.

Akka 
Akka is a toolkit and runtime for building highly concurrent, distributed, and fault tolerant
event-driven applications on the JVM.

Amazon Ion Java 
Amazon Ion Java is a Java streaming parser/serializer for Ion. It is the reference
implementation of the Ion data notation for the Java Platform Standard Edition 8 and
above.

Amazon SQS Java Messaging Library 
This Amazon SQS Java Messaging Library holds the Java Message Service compatible
classes, that are used for communicating with Amazon Simple Queue Service.

Animal Sniffer Annotations 
Animal Sniffer Annotations provides Java 1.5+ annotations which allow marking methods
which Animal Sniffer should ignore signature violations of.

ansi-escapes 
ANSI escape codes for manipulating the terminal

ansi-styles 
ANSI escape codes for styling strings in the terminal

ANTLR 
ANTLR is a powerful parser generator that you can use to read, process, execute, or
translate structured text or binary files.

Apache ActiveMQ 
Apache ActiveMQ is the most popular and powerful open source messaging and
Integration Patterns server.

Apache Ant 
Apache Ant is a Java library and command-line tool whose mission is to drive processes
described in build files as targets and extension points dependent upon each other. The
main known usage of Ant is the build of Java applications. Ant supplies a number of built-in
tasks allowing to compile, assemble, test and run Java applications. Ant can also be used
effectively to build non Java applications, for instance C or C++ applications. More
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generally, Ant can be used to pilot any type of process which can be described in terms of
targets and tasks.

Apache Commons BeanUtils 
The Java language provides Reflection and Introspection APIs (see the java.lang.reflect and
java.beans packages in the JDK Javadocs). However, these APIs can be quite complex to
understand and utilize. The BeanUtils component provides easy-to-use wrappers around
these capabilities.

Apache Commons Codec 
Apache Commons Codec (TM) software provides implementations of common encoders
and decoders such as Base64, Hex, Phonetic and URLs.

Apache Commons Collections 
The Java Collections Framework was a major addition in JDK 1.2. It added many powerful
data structures that accelerate development of most significant Java applications. Since
that time it has become the recognized standard for collection handling in Java.

Apache Commons Compress 
The Apache Commons Compress library defines an API for working with ar, cpio, Unix
dump, tar, zip, gzip, XZ, Pack200, bzip2, 7z, arj, lzma, snappy, DEFLATE, lz4 and Z files.

Apache Commons Configuration 
The Commons Configuration software library provides a generic configuration interface
which enables a Java application to read configuration data from a variety of sources.
Commons Configuration provides typed access to single, and multi-valued configuration
parameters.

Apache Commons DBCP (Database Connection Pools) 
Many Apache projects support interaction with a relational database. Creating a new
connection for each user can be time consuming (often requiring multiple seconds of clock
time), in order to perform a database transaction that might take milliseconds. Opening
a connection per user can be unfeasible in a publicly-hosted Internet application where the
number of simultaneous users can be very large. Accordingly, developers often wish to
share a "pool" of open connections between all of the application's current users. The
number of users actually performing a request at any given time is usually a very small
percentage of the total number of active users, and during request processing is the only
time that a database connection is required. The application itself logs into the DBMS,
and handles any user account issues internally. There are several Database Connection
Pools already available, both within Apache products and elsewhere. This Commons
package provides an opportunity to coordinate the efforts required to create and maintain
an efficient, feature-rich package under the ASF license.

Apache Commons FileUpload 
The Commons FileUpload package makes it easy to add robust, high-performance, file
upload capability to your servlets and web applications.

Apache Commons HttpClient 
HttpClient was started in 2001 as a subproject of the Jakarta Commons, based on code
developed by the Jakarta Slide project.

Apache Commons IO 
Commons IO is a library of utilities to assist with developing IO functionality.
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Apache Commons JEXL (Java EXpression Language) 
JEXL is a library intended to facilitate the implementation of dynamic and scripting features
in applications and frameworks written in Java.

JEXL implements an Expression Language based on some extensions to the JSTL
Expression Language supporting most of the constructs seen in shell-script or ECMAScript.
Its goal is to expose scripting features usable by technical operatives or consultants
working with enterprise platforms.

Apache Commons Lang 
The standard Java libraries fail to provide enough methods for manipulation of its core
classes. Apache Commons Lang provides these extra methods.

Lang provides a host of helper utilities for the java.lang API, notably String manipulation
methods, basic numerical methods, object reflection, concurrency, creation and
serialization and System properties. Additionally it contains basic enhancements to
java.util.Date and a series of utilities dedicated to help with building methods, such as
hashCode, toString and equals.

Apache Commons Logging 
The Logging package is an ultra-thin bridge between different logging implementations.
A library that uses the commons-logging API can be used with any logging implementation
at runtime. Commons-logging comes with support for a number of popular logging
implementations, and writing adapters for others is a reasonably simple task.

Apache Commons Net 
Apache Commons Net™ library implements the client side of many basic Internet
protocols. The purpose of the library is to provide fundamental protocol access, not
higher-level abstractions.

Apache Commons Pool 
Pool provides an Object-pooling API, with three major aspects:
1. A generic object pool interface that clients and implementers can use to provide

easily interchangeable pooling implementations.
2. A toolkit for creating modular object pools.
3. Several general purpose pool implementations.

Apache FOP 
Apache FOP (Formatting Objects Processor) is a print formatter driven by XSL formatting
objects (XSL-FO) and an output independent formatter. It is a Java application that reads a
formatting object (FO) tree and renders the resulting pages to a specified output. Output
formats currently supported include PDF, PS, PCL, AFP, XML (area tree representation),
Print, AWT and PNG, and to a lesser extent, RTF and TXT. The primary output target is PDF.

Apache Geronimo 
Apache Geronimo is an open source server runtime that integrates the best open source
projects to create Java/OSGi server runtimes that meet the needs of enterprise developers
and system administrators.

Apache HttpClient 
Although the java.net package provides basic functionality for accessing resources via
HTTP, it doesn't provide the full flexibility or functionality needed by many applications.
HttpClient seeks to fill this void by providing an efficient, up-to-date, and feature-rich
package implementing the client side of the most recent HTTP standards and
recommendations.
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Designed for extension while providing robust support for the base HTTP protocol,
HttpClient may be of interest to anyone building HTTP-aware client applications such as
web browsers, web service clients, or systems that leverage or extend the HTTP protocol
for distributed communication.

Apache HttpComponents 
The Apache HttpComponents™ project is responsible for creating and maintaining a
toolset of low level Java components focused on HTTP and associated protocols.

Within the HttpComponents project, HttpCore is a set of low level HTTP transport
components that can be used to build custom client and server side HTTP services with a
minimal footprint. HttpCore supports two I/O models: blocking I/O model based on the
classic Java I/O and non-blocking, event driven I/O model based on Java NIO

Apache Log4j 
Apache Log4j 2 is an upgrade to Log4j that provides significant improvements over its
predecessor, Log4j 1.x, and provides many of the improvements available in Logback while
fixing some inherent problems in Logback's architecture.

Apache Lucene, SOLR 
The Apache Lucene™ project develops open-source search software.

Apache Tomcat, Tomcat Embed 
Apache Tomcat is an open source software implementation of the Java Servlet and
JavaServer Pages technologies.

Apache XBean :: Spring 
XBean :: Spring provides a schema-driven proprietary namespace handler for Spring
contexts.

Apache Xerces 
The Apache Xerces Project is responsible for software licensed to the Apache Software
Foundation intended for the creation and maintenance of:

• XML parsers

• related software components

Apache XML 
The Apache XML Project used to be the home for many XML-related subprojects, many of
which have moved to top-level project status recently or are currently in migration. The
Apache XML Project slowly transforms into an place where you can find pointers to
XML-related projects here in The Apache Foundation.

Apache XML Commons External Components 
The External Components portion of xml-commons contains interfaces that are defined
by external standards organizations.

archiver 
A streaming interface for archive generation.

archiver-utils 
A streaming interface for archive generation.
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array-tree-filter 
Filter by keys in array tree

ASM 
ASM is an all purpose Java bytecode manipulation and analysis framework. It can be used
to modify existing classes or dynamically generate classes, directly in binary form.
Provided common transformations and analysis algorithms allow to easily assemble
custom complex transformations and code analysis tools.

AspectJ 
AspectJ is a seamless aspect-oriented extension to the Java programming language. It is
Java platform compatible easy to learn and use.

Async 
Async is a utility module which provides straight-forward, powerful functions for working
with asynchronous JavaScript.

async-validator 
Validate form asynchronous. A variation of https://github.com/freeformsystems/async
-validate 

AWS SDK for Amazon SQS 
The AWS Java SDK for Amazon SQS module holds the client classes that are used for
communicating with Amazon Simple Queue Service.

AWS SDK for Java Core 
The AWS SDK for Java - Core module holds the classes that are used by the individual
service clients to interact with Amazon Web Services. Users need to depend on
aws-java-sdk artifact for accessing individual client classes.

b4a 
Buffer for Array (B4A) provides a set of functions for bridging the gap between the Node.js
Buffer class and the Uint8Array class. A browser compatibility layer is also included,
making it possible to use B4A in both Node.js and browsers without having to worry about
whether you're dealing with buffers or typed arrays.

base64-js 
base64-js does basic base64 encoding/decoding in pure JS.

bl 
A Node.js Buffer list collector, reader and streamer thingy.

buffer 
The buffer module from node.js, for the browser.

buffer-crc32 
crc32 that works with binary data and fancy character sets, outputs buffer, signed or
unsigned data and has tests.

Byte Buddy 
Byte Buddy is a code generation and manipulation library for creating and modifying Java
classes during the runtime of a Java application and without the help of a compiler.
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camelize 
recursively transform key strings to camel-case

CDI APIs 
APIs for CDI (Contexts and Dependency Injection for Java).

cglib 
cglib is a powerful, high performance and quality Code Generation Library, It is used to
extend JAVA classes and implements interfaces at runtime.

chalk 
Terminal string styling done right

chardet 
Chardet is a character detection module written in pure JavaScript (TypeScript). Module
uses occurrence analysis to determine the most probable encoding.

Checker Qual 
Checker Qual is the set of annotations (qualifiers) and supporting classes used by the
Checker Framework to type check Java source code.

ClassMate 
ClassMate is a library for introspecting generic type information of types, member/static
methods, fields. Especially useful for POJO/Bean introspection.

classnames 
classnames is a simple JavaScript utility for conditionally joining classNames together.

cli-cursor 
Toggle the CLI cursor. The cursor is gracefully restored if the process exits.

cli-spinners 
70+ spinners for use in the terminal

cli-width 
Get stdout window width, with four fallbacks, tty, output.columns, a custom environment
variable and then a default.

commander 
The complete solution for node.js command-line interfaces.

CommandLineParser 
C# command line parser that brings standardized *nix getopt style, for .NET. Includes F#
support.

compress-commons 
Compress Commons is a library that defines a common interface for working with archive
formats within node.

Config (Typesafe) 
A configuration library for JVM languages.

crc-32 
Standard CRC-32 algorithm implementation in JS (for the browser and nodejs). Emphasis
on correctness, performance, and IE6+ support.
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crc32-stream 
crc32-stream is a streaming CRC32 checksumer. It uses the crc module behind the scenes
to reliably handle binary data and fancy character sets. Data is passed through untouched.

cross-spawn 
A cross platform solution to node's spawn and spawnSync.

css-color-keywords 
A list of all CSS color keywords.

css-to-react-native 
Convert CSS text to a React Native stylesheet object

csstype 
Strict TypeScript and Flow types for style based on MDN data

date-fns 
date-fns provides the most comprehensive, yet simple and consistent toolset for
manipulating JavaScript dates in a browser & Node.js

dayjs 
Day.js is a minimalist JavaScript library that parses, validates, manipulates, and displays
dates and times for modern browsers with a largely Moment.js-compatible API. If you use
Moment.js, you already know how to use Day.js.

decamelize 
Convert a camelized string into a lowercased one with a custom separator. Example:
unicornRainbow → unicorn_rainbow

diff 
A JavaScript text differencing implementation.

DITA-OT 
The DITA Open Toolkit is a Java-based implementation of the OASIS DITA Technical
Committee's specification for DITA DTDs and schemas. It contains ANT, SAXON,...

DockPanel Suite 
.Net Docking Library for Windows Forms

dom4j 
dom4j is an easy to use, open source library for working with XML, XPath and XSLT on the
Java platform using the Java Collections Framework and with full support for DOM, SAX
and JAXP.

dsinfo 
The dsinfo library enables you to easily use Scala-side information in implementations of
embedded (internal) domain-specific languages. dsinfo is implemented using Scala
macros which are an experimental feature of Scala 2.10 and 2.11.

dsprofile 
The dsprofile library provides general facilities to implement domain-specific profiling in
Scala and Java programs.

edtFTPj/Free 
Free Java FTP library gives Java developers extensive FTP functionality.
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Ehcache 
Ehcache is an open source, standards-based cache for boosting performance, offloading
your database, and simplifying scalability. It's the most widely-used Java-based cache
because it's robust, proven, and full-featured. Ehcache scales from in-process, with one or
more nodes, all the way to mixed in-process/out-of-process configurations with
terabyte-sized caches.

Elasticsearch RESTful client 
A RESTful client for the Elasticsearch search engine.

emoji-regex 
emoji-regex offers a regular expression to match all emoji symbols and sequences
(including textual representations of emoji) as per the Unicode Standard. It’s based
on emoji-test-regex-pattern, which generates (at build time) the regular expression
pattern based on the Unicode Standard. As a result, emoji-regex can easily be updated
whenever new emoji are added to Unicode.

Error Prone 
Error Prone is a static analysis tool for Java that catches common programming mistakes
at compile-time.

excss 
ExCSS (Pronounced Excess) is a CSS 2.1 and CSS 3 parser for .NET. The goal of ExCSS is to
make it easy to read and parse stylesheets into a friendly object model with full LINQ
support.

external-editor 
A node module to edit a string with a users preferred text editor using $VISUAL or
$ENVIRONMENT.

fast-fifo 
A fast fifo implementation similar to the one powering nextTick in Node.js core. Uses a
linked list of growing fixed sized arrays to implement the FIFO to avoid allocating a
wrapper object for each item.

FastInfoSet 
Fast Infoset (or FI) is an international standard that specifies a binary encoding format for
the XML Information Set (XML Infoset) as an alternative to the XML document format. It
aims to provide more efficient serialization than the text-based XML format.

Fast Serialization 
Fast Serialization reimplements Java Serialization with focus on speed (up to 10 times
faster), size and compatibility. This allows the use of FST with minimal code change.

figures 
Unicode symbols with fallbacks for older terminals

Fizzler 
Fizzler is a W3C Selectors parser and generic selector framework for document hierarchies.

fn-name 
Get the name of a named function. There is a name property on functions, but it's not
supported in all browsers. This module tries that property then falls back to extracting the
name from the function source.
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Font Awesome 
Font Awesome gives you scalable vector icons that can instantly be customized - size,
color, drop shadow, and anything that can be done with the power of CSS.

Fonto Editor 
Fonto is an online XML editor designed for people with no knowledge of XML or any
other technology that comes with structured content authoring.

fs-extra 
fs-extra adds file system methods that aren't included in the native fs module and adds
promise support to the fs methods. It also uses graceful-fs to prevent EMFILE errors. It
should be a drop in replacement for fs.

fs.realpath 
A backwards-compatible fs.realpath for Node v6 and above. In Node v6, the JavaScript
implementation of fs.realpath was replaced with a faster (but less resilient) native
implementation. That raises new and platform-specific errors and cannot handle long or
excessively symlink-looping paths. This module handles those cases by detecting the new
errors and falling back to the JavaScript implementation. On versions of Node prior to
v6, it has no effect.

GeckoFX
Gecko is a free and open source layout engine used in many applications developed by
the Mozilla Foundation and the Mozilla Corporation (notably the Firefox web browser).

geckofx45.64 
library that allows embedding gecko in C# applications.

glob 
glob functionality for node.js

globalize 
JavaScript globalization and localization. Formats and parses strings, dates and numbers
in over 350 cultures.

GNU Aspell 
GNU Aspell is a Free and Open Source spell checker designed to eventually replace Ispell.
It can either be used as a library or as an independent spell checker. Its main feature is
that it does a superior job of suggesting possible replacements for a misspelled word than
just about any other spell checker out there for the English language. Unlike Ispell, Aspell
can also easily check documents in UTF-8 without having to use a special dictionary.
Aspell will also do its best to respect the current locale setting. Other advantages over
Ispell include support for using multiple dictionaries at once and intelligently handling
personal dictionaries when more than one Aspell process is open at once.

Specifically we are using GNUASpell dictionaries for de-CH, de-DE, en-CA, en-GB, en-US,
es-ES, fr-FR, fr-CH, nl-NL.

google-code-prettify 
google-code-prettify is a Javascript module and CSS file that allows syntax highlighting in
an html page.

google-gson 
google-gson is a Java library to convert JSON to Java objects and vice-versa.
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Google Guava 
The Guava project contains several of Google's core libraries that we rely on in our
Java-based projects: collections, caching, primitives support, concurrency libraries,
common annotations, string processing, I/O, and so forth.

Google J2ObjC 
J2ObjC is an open-source command-line tool from Google that translates Java source
code to Objective-C for the iOS (iPhone/iPad) platform. This tool enables Java source to be
part of an iOS application's build, as no editing of the generated files is necessary.

graceful-fs 
graceful-fs functions as a drop-in replacement for the fs module, making various
improvements. The improvements are meant to normalize behavior across different
platforms and environments, and to make filesystem access more resilient to errors.

GraphQL-Java 
The Java implementation of GraphQL.

HdrHistogram 
A High Dynamic Range Histogram that supports recording and analyzing sampled data
value counts across a configurable integer value range with configurable value precision
within the range. Value precision is expressed as the number of significant digits in the
value recording, and provides control over value quantization behavior across the value
range and the subsequent value resolution at any given level.

Hibernate 
Hibernate is a high-performance Object/Relational persistence and query service. The
most flexible and powerful Object/Relational solution on the market, Hibernate takes care
of the mapping from Java classes to database tables and from Java data types to SQL
data types. It provides data query and retrieval facilities that significantly reduce
development time. Hibernate's design goal is to relieve the developer from 95% of
common data persistence-related programming tasks by eliminating the need for manual,
hand-crafted data processing using SQL and JDBC.

HK2 Framework 
HK2 is a light-weight and dynamic dependency injection framework.

HSQLDB (HyperSQL DataBase) 
HSQLDB (HyperSQL DataBase) is the leading SQL relational database engine written in
Java. It offers a small, fast multithreaded and transactional database engine with
in-memory and disk-based tables and supports embedded and server modes. It includes
a powerful command line SQL tool and simple GUI query tools.

Hunspell 
Hunspell is the spell checker of LibreOffice, OpenOffice.org, Mozilla Firefox 3 &
Thunderbird, Google Chrome, and it is also used by proprietary software packages, like
Mac OS X, InDesign, MemoQ, Opera and Trados Studio.

i18next-http-backend 
This is a simple i18next backend to be used in Node.js, in the browser and for Deno. It will
load resources from a backend server using the XMLHttpRequest or the fetch API.
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i18next-intervalplural-postprocessor 
This is a i18next postProcessor enabling interval based plurals.

iconv-lite 
Convert character encodings in pure javascript.

IdentityModel 
A .NET standard helper library for claims-based identity, OAuth 2.0 and OpenID Connect.

IdentityModel OidcClient 
A C#/NetStandard OpenID Connect Client Library for native Applications.

ieee754 
Read/write IEEE754 floating point numbers from/to a Buffer or array-like object.

inflight 
Add callbacks to requests in flight to avoid async duplication

inherits 
Easy simple tiny inheritance in JavaScript

inquirer 
A collection of common interactive command line user interfaces.

InstallAnywhere 
InstallAnywhere is the leading multi-platform development solution for application
producers who need to deliver a professional and consistent cross installation experience
for physical, virtual and cloud environments. From a single project file and build
environment, InstallAnywhere creates reliable installations for on-premises platforms -
Windows, Linux, Apple OS X, Solaris, AIX , HP-UX, and IBM iSeries - and enables you to take
existing and new software products to a virtual and cloud infrastructure.

is-fullwidth-code-point 
Check if the character represented by a given Unicode code point is fullwidth

is-interactive 
Check if stdout or stderr is interactive

is-unicode-supported 
Detect whether the terminal supports Unicode

Jackson tooling 
Inspired by the quality and variety of XML tooling available for the Java platform (StAX,
JAXB, etc.), the Jackson is a multi-purpose Java library for processing JSON data format.
Jackson aims to be the best possible combination of fast, correct, lightweight, and
ergonomic components for developers.

Jakarta Activation API 
The JavaBeans Activation Framework API JAR.

Jakarta XML Bind API 
Jakarta's XML bind API.

Java API for RESTful web services (javax.ws.rs) 
Java API for RESTful Web Services.
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JavaBeans Activation Framework 
With the JavaBeans Activation Framework standard extension, developers who use Java
technology can take advantage of standard services to determine the type of an arbitrary
piece of data, encapsulate access to it, discover the operations available on it, and to
instantiate the appropriate bean to perform said operation(s).

JavaBeans Validation 
Bean Validation (JSR-303) API.

Javassist (Java Programming Assistant) 
Javassist (Java Programming Assistant) makes Java bytecode manipulation simple. It is a
class library for editing bytecodes in Java; it enables Java programs to define a new class at
runtime and to modify a class file when the JVM loads it. Unlike other similar bytecode
editors, Javassist provides two levels of API: source level and bytecode level. If the users
use the source-level API, they can edit a class file without knowledge of the specifications
of the Java bytecode. The whole API is designed with only the vocabulary of the Java
language. You can even specify inserted bytecode in the form of source text; Javassist
compiles it on the fly. On the other hand, the bytecode-level API allows the users to directly
edit a class file as other editors.

javax.annotation 
JSR 250 Common Annotations For The Java Platform.

javax.cache 
Caching Java API

Javax Expression Language 
Expression Language Java API

javax.inject 
Dependency Injection Java API

javax.validation 
Bean Validation API

javax.jms 
The Java Message Service (JMS) API is a messaging standard that allows application
components based on the Java 2 Platform, Enterprise Edition (J2EE) to create, send,
receive, and read messages. It enables distributed communication that is loosely coupled,
reliable, and asynchronous.

JAXB 
The goal of the JAXB project is to develop and evolve the code base for the Reference
Implementation (RI) of JAXB, the Java Architecture for XML Binding. The JAXB specification
is developed through the Java Community Process following the process described at
jcp.org . This process involves an Expert Group with a lead that is responsible for delivering
the specification, a reference implementation (RI) and a Technology Compatibility Kit (TCK
). The primary goal of an RI is to support the development of the specification and to
validate it. Specific RIs can have additional goals; the JAXB RI is a production-quality
implementation that is used directly in a number of products by Oracle and other vendors.

JBoss Java Annotation Indexer (Jandex) 
A Java Annotation Indexer for JBoss

A Acknowledgments

92 Tridion Docs Content Manager upgrade guide

http://www.oracle.com/technetwork/java/javase/downloads/index-135046.html
https://jcp.org/en/jsr/detail?id=303
http://www.javassist.org/
https://mvnrepository.com/artifact/javax.annotation
http://mvnrepository.com/artifact/javax.cache
https://mvnrepository.com/artifact/javax.el
https://docs.oracle.com/javaee/6/api/javax/inject/package-summary.html
https://mvnrepository.com/artifact/javax.validation/validation-api/2.0.1.Final
https://mvnrepository.com/artifact/javax.jms
https://jaxb.java.net/
http://www.jcp.org/en/procedures/overview
https://github.com/wildfly/jandex


JBoss Logging Framework 
The JBoss Logging Framework.

jedis 
A blazingly small and sane Redis Java client.

Jersey RESTful WS 
Developing RESTful Web services that seamlessly support exposing your data in a variety
of representation media types and abstract away the low-level details of the client-
server communication is not an easy task without a good toolkit. In order to simplify
development of RESTful Web services and their clients in Java, a standard and portable
JAX-RS API has been designed. Jersey RESTful Web Services framework is open source,
production quality, framework for developing RESTful Web Services in Java that provides
support for JAX-RS APIs and serves as a JAX-RS (JSR 311 & JSR 339) Reference
Implementation.

Jettison 
Jettison is a collection of Java APIs (like STaX and DOM) which read and write JSON. This
allows nearly transparent enablement of JSON based web services in services frameworks
like CXF or XML serialization frameworks like XStream.

Jetty 
The Jetty Web Server provides an HTTP server and Servlet container capable of serving
static and dynamic content either from a standalone or embedded instantiations. Starting
from Jetty version 7, the Jetty webserver and other core compoments are hosted by the
Eclipse Foundation.

JLine 
JLine is a Java library for handling console input. It is similar in functionality to BSD editline
and GNU readline. People familiar with the readline/editline capabilities for modern
shells (such as bash and tcsh) will find most of the command editing features of JLine to
be familiar.

JMESPath Java 
JMESPath is a query language for JSON. You can extract and transform elements from a
JSON document. This is a Java implementation

Joda-Convert 
Joda-Convert provides a small set of classes to provide round-trip conversion between
Objects and Strings. It does not tackle the wider problem of Object to Object
transformation.

Joda-Time 
Joda-Time provides a quality replacement for the Java date and time classes. The design
allows for multiple calendar systems, while still providing a simple API. The 'default'
calendar is the http://www.joda.org/joda-time/cal_iso.html standard which is used by
XML. The Gregorian, Julian, Buddhist, Coptic, Ethiopic and Islamic systems are also
included, and we welcome further additions. Supporting classes include time zone,
duration, format and parsing.

JOL (Java Object Layout) 
JOL (Java Object Layout) is the tiny toolbox to analyze object layout schemes in JVMs.
These tools are using Unsafe, JVMTI, and Serviceability Agent (SA) heavily to decoder the
actual object layout, footprint, and references.
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jQuery 
jQuery is a fast, small, and feature-rich JavaScript library. It makes things like HTML
document traversal and manipulation, event handling, animation, and Ajax much simpler
with an easy-to-use API that works across a multitude of browsers. With a combination
of versatility and extensibility, jQuery has changed the way that millions of people write
JavaScript.

jQuery CheckBoxTree 
A jQuery based checkbox tree plugin that displays your hierarchical data in a tree structure
with checkboxes.

jquery-cookie 
jQuery plugin for reading, writing and deleting cookies.

jquery.datatables 
DataTables is a plug-in for the jQuery Javascript library. It is a highly flexible tool, based
upon the foundations of progressive enhancement, which will add advanced interaction
controls to any HTML table.

jquery.dataTables.columnFilter 
Adds advanced filter capabilities to the DataTables. JS file.

jQueryFileUpload 
File Upload widget with multiple file selection, drag&drop support, progress bar, validation
and preview images, audio and video for jQuery.

jquery.TypeScript.DefinitelyTyped 
TypeScript Definitions (d.ts) for jquery.

jQuery.Gantt 
Draw Gantt charts with the famous jQuery ease of development.

jQuery Highlight 
Highlights the search keywords/terms in a preview.

jQuery UI 
jQuery UI is a set of user interface interactions, effects, widgets, and themes built on top
of the jQuery JavaScript Library.

json2mq 
Generate media query string from JSON or javascript object

jsonfile 
Easily read/write JSON files in Node.js. Note: this module cannot be used in the browser.

jSON-js 
JSON is a light-weight, language independent, data interchange format. See
http://www.JSON.org / The files in this collection implement JSON encoders/decoders in
JavaScript. JSON became a built-in feature of JavaScript when the ECMAScript Programming
Language Standard - Fifth Edition was adopted by the ECMA General Assembly in
December 2009. Most of the files in this collection are for applications that are expected
to run in obsolete web browsers. For most purposes, json2.js is the best choice.
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Json.NET 
Json.NET is a popular high-performance JSON framework for .NET.

jsoup 
jsoup is a Java library for working with real-world HTML. It provides a very convenient API
for extracting and manipulating data, using the best of DOM, CSS, and jquery-like
methods.

JTA (Java Transaction API) 
The javax.transaction package. It is appropriate for inclusion in a classpath, and may
be added to a Java 2 installation.

Kiama 
The Kiama test library contains a collection of examples, tests that use those examples,
and useful test support code.

Knockout JavaScript library 
Knockout is a JavaScript library that helps you to create rich, responsive display and editor
user interfaces with a clean underlying data model. Any time you have sections of UI
that update dynamically (e.g., changing depending on the user’s actions or when an
external data source changes), KO can help you implement it more simply and
maintainably.

Kryo 
Kryo is a fast and efficient binary object graph serialization framework for Java. The goals
of the project are high speed, low size, and an easy to use API. The project is useful any
time objects need to be persisted, whether to a file, database, or over the network.

Kryo can also perform automatic deep and shallow copying/cloning. This is direct copying
from object to object, not object to bytes to object.

kXML 2 
kXML is a small XML pull parser, specially designed for constrained environments such as
Applets, Personal Java or MIDP devices. In contrast to kXML 1, kXML 2 is based on the
XML pull API.

LatencyUtils 
The LatencyUtils package includes useful utilities for tracking latencies. Especially in
common in-process recording scenarios, which can exhibit significant coordinated
omission sensitivity without proper handling.

lazystream 
Create streams lazily when they are accessed (read from/written to).

lodash.isequalwith 
A modern JavaScript utility library delivering modularity, performance, & extras.

lodash-es 
A modern JavaScript utility library delivering modularity, performance, & extras.

Logback 
Logback is intended as a successor to the popular log4j project, picking up where log4j
leaves off.
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log-symbols 
Colored symbols for various log levels

loose-envify 
Fast (and loose) selective process.env replacer using js-tokens instead of an AST. Works
just like envify but much faster.

MapStruct 
MapStruct is a code generator that greatly simplifies the implementation of mappings
between Java bean types based on a convention over configuration approach. The
generated mapping code uses plain method invocations and thus is fast, type-safe and
easy to understand.

MathJAX 
MathJax is an open-source JavaScript display engine for LaTeX, MathML, and AsciiMath
notation that works in all modern browsers. It was designed with the goal of consolidating
the recent advances in web technologies into a single, definitive, math-on-the-web
platform supporting the major browsers and operating systems.

Micrometer 
Micrometer provides a simple facade over the instrumentation clients for the most
popular monitoring systems, allowing you to instrument your JVM-based application
code without vendor lock-in. Think SLF4J, but for metrics.

Microsoft.Bcl.AsyncInterfaces 
Provides the IAsyncEnumerable<T> and IAsyncDisposable interfaces and helper types for
.NET Standard 2.0. This package is not required starting with .NET Standard 2.1 and .NET
Core 3.0.

microsoft.extensions.configuration.abstractions 
Provides abstractions of key-value pair based configuration. Interfaces defined in this
package are implemented by classes in Microsoft.Extensions.Configuration and other
configuration packages.

microsoft.extensions.dependencyinjection 
Supports the dependency injection (DI) software design pattern which is a technique for
achieving Inversion of Control (IoC) between classes and their dependencies.

microsoft.extensions.dependencyinjection.abstractions 
Supports the lower-level abstractions for the dependency injection (DI) software design
pattern which is a technique for achieving Inversion of Control (IoC) between classes and
their dependencies.

microsoft.extensions.logging 
Microsoft.Extensions.Logging is combined with a core logging abstraction
under Microsoft.Extensions.Logging.Abstractions. This abstraction is available in our
basic built-in implementations like console, event log, and debug (Debug.WriteLine)
logging.

microsoft.extensions.logging.abstractions 
Microsoft.Extensions.Logging.Abstractions provides abstractions of logging. Interfaces
defined in this package are implemented by classes in Microsoft.Extensions.Logging and
other logging packages. This package includes a logging source generator that produces
highly efficient and optimized code for logging message methods.
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microsoft.extensions.options 
Microsoft.Extensions.Options provides a strongly typed way of specifying and accessing
settings using dependency injection and acts as a bridge between configuration, DI, and
higher level libraries. This library is the glue for how an app developer uses DI to configure
the behavior of a library like HttpClient Factory. This also enables user to get a
strongly-typed view of their configuration. Within this package, you'll find an options
validation source generator that generates exceptionally efficient and optimized code for
validating options.

microsoft.extensions.primitives 
Microsoft.Extensions.Primitives contains isolated types that are used in many places
within console or ASP.NET Core applications using framework extensions.

microsoft.extensions.dependencyinjection 
Supports the dependency injection (DI) software design pattern which is a technique for
achieving Inversion of Control (IoC) between classes and their dependencies.

microsoft.identitymodel.abstractions 
A package containing thin abstractions for Microsoft.IdentityModel.

microsoft.identitymodel.jsonwebtokens 
Includes types that provide support for creating, serializing and validating JSON Web
Tokens. This is a newer, faster version of System.IdentityModel.Tokens.Jwt that has
additional functionality.

microsoft.identitymodel.logging 
Includes Event Source based logging support.

microsoft.identitymodel.protocols 
Provides base protocol support for OpenIdConnect and WsFederation.

microsoft.identitymodel.protocols.openidconnect 
Includes types that provide support for OpenIdConnect protocol.

microsoft.identitymodel.tokens 
Includes types that provide support for SecurityTokens, Cryptographic operations: Signing,
Verifying Signatures, Encryption.

Microsoft JDBC Driver for SQL Server 
Microsoft provides a Java Database Connectivity ( JDBC) driver for use with SQL Server,
and Azure SQL Database. The driver provides Java database connectivity from any Java
application, application server, or Java-enabled applet. This driver is a Type 4 JDBC driver
that provides database connectivity through the standard JDBC application program
interfaces (APIs).

microsoft-windowsapicodepack-core 
This is a fork of the Microsoft Windows API Code Pack, based on a repository created
by Aybe. Due to the lack of updates to the original package, this fork was created to include
all open pull requests on the original repository, apply fixes and add support for all
current .NET Framework and .NET Core versions.

microsoft-windowsapicodepack-shell 
This is a fork of the Microsoft Windows API Code Pack, based on a repository created
by Aybe. Due to the lack of updates to the original package, this fork was created to include
all open pull requests on the original repository, apply fixes and add support for all
current .NET Framework and .NET Core versions.
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minimatch 
A minimal matching utility. This is the matching library used internally by npm. It works
by converting glob expressions into JavaScript RegExp objects.

minimist 
parse argument options

Minlog 
MinLog is a tiny Java logging library.

mute-stream 
Bytes go in, but they don't come out (when muted). This is a basic pass-through stream,
but when muted, the bytes are silently dropped, rather than being passed through.

MXP1 
MXP1 is a stable XmlPull parsing engine that is based on ideas from XPP and in particular
XPP2 but completely revised and rewritten to take the best advantage of latest JIT JVMs
such as Hotspot in JDK 1.4+.

nanoid 
A tiny (124 bytes), secure, URL-friendly, unique string ID generator for JavaScript

neo-async 
Neo-Async is thought to be used as a drop-in replacement for Async, it almost fully covers
its functionality and runs faster

NHunspell 
NHunspell brings the spell checking, hyphenation and thesaurus to the Microsoft® .NET
Framework. NHunspell is C# library and wraps native libraries for Hunspell, Hyphen and
MyThes. One design goal of this library and wrapper is to keep the source code of the
included libraries as unmodified as possible. New versions of the base libraries can
therefore easily adopted to NHunspell.

The integrated libraries are used in OpenOffice and they work with the dictionaries
published on OpenOffice.org.

NLog 
NLog is a flexible and free logging platform for various .NET platforms, including .NET
standard. NLog makes it easy to write to several targets. (database, file, console) and
change the logging configuration on-the-fly.

nlog.extensions.logging 
NLog.Extensions.Logging makes it possible to use NLog together with Microsoft ILogger-
abstraction and Dependency Injection.

NLog.WindowsEventLog 
NLog.WindowsEventLog provides access to the EventLog-target for NetStandard

normalize-path 
Normalize slashes in a file path to be posix/unix-like forward slashes. Also condenses
repeat slashes to a single slash and removes and trailing slashes, unless disabled.

Objenesis 
Objenesis is a small Java library that serves one purpose: to instantiate a new object of a
particular class.
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okhttp 
An HTTP+HTTP/2 client for Android and Java applications.

okio 
A modern I/O API for Java.

once 
Run a function exactly one time

ora 
Elegant terminal spinner

Oracle JDBC Drivers 
Drivers used for making a JDBC connection from Java to an Oracle database.

Oracle PKI (Public Key Infrastructure) 
Oracle public key infrastructure (PKI) is used by Oracle Enterprise Security Manager,
LDAP-enabled Oracle Enterprise Manager, Oracle's Secure Socket Layer (SSL)
authentication, Oracle Database, and Oracle Application Server.

Oracle Security Developer Tools (OSDT) 
Oracle Security Developer Tools provide you with the cryptographic building blocks
necessary for developing robust security applications, ranging from basic tasks like secure
messaging to more complex projects such as securely implementing a service-oriented
architecture. The tools build upon the core foundations of cryptography, public key
infrastructure, web services security, and federated identity management.

path-key 
Get the PATH environment variable key cross-platform

Path-to-RegExp 
Turn a path string such as `/user/:name` into a regular expression.

PATRICIA Trie in Java 
An implementation of the Practical Algorithm to Retrieve Information Coded in
Alphanumeric (PATRICIA).

picocolors 
The tiniest and the fastest library for terminal output formatting with ANSI colors.

Postal.Mvc5 
Generate emails using ASP.NET MVC views

postcss 
PostCSS is a tool for transforming styles with JS plugins. These plugins can lint your CSS,
support variables and mixins, transpile future CSS syntax, inline images, and more.

postcss-value-parser 
Transforms CSS declaration values and at-rule parameters into a tree of nodes, and
provides a simple traversal API.

Project Reactor 
Reactor is a fourth-generation Reactive library for building non-blocking applications on
the JVM based on the Reactive Streams Specification.
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property-expr 
Tiny property path utilities, including path parsing and metadata and deep property
setters and getters

PS Cmdlet Help Editor 
PowerShell Cmdlet Help Editor is the tool that helps you to create and edit XML-based
help files for your PowerShell modules and PSSnap-Ins.

qrcode.react 
A React component to generate QR codes for rendering to the DOM.

queue-tick 
Next tick shim that prefers process.nextTick over queueMicrotask for compat

rc-align 
React Align Component. Wrapper around https://github.com/yiminghe/dom-align.

rc-cascader 
React Cascader Component. Cascade select in one box

rc-checkbox 
Checkbox ui component for react.

rc-collapse 
React Collapse / Accordion. rc-collapse ui component for react

rc-dialog 
react dialog component

rc-drawer 
React Drawer

rc-dropdown 
react dropdown component

rc-field-form 
React Performance First Form Component.

rc-image 
React Image.

rc-input 
React Input Component

rc-input-number 
React Input Number

rc-mentions 
React Mentions

rc-menu 
React menu component. port from https://github.com/kissyteam/menu

rc-motion 
React lifecycle controlled motion library.
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rc-notification 
React Notification UI Component

rc-overflow 
Auto collapse box when overflow

rc-pagination 
React Pagination Component.

rc-picker 
All Date Pickers you need.

rc-progress 
React Progress Bar

rc-rate 
React Rate Component

rc-resize-observer 
Resize observer for React.

rc-segmented 
React Segmented Control.

rc-select 
React Select

rc-slider 
Slider UI component for React

rc-steps 
React steps component.

rc-switch 
Switch ui component for react.

rc-table 
React table component with useful functions.

rc-tabs 
React Tabs component.

rc-textarea 
Pretty Textarea react component used in ant.design.

rc-tooltip 
React Tooltip

rc-tree 
Tree component.

rc-tree-select 
React TreeSelect Component

rc-trigger 
React Trigger Component
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rc-upload 
React Upload

rc-util 
Common Utils For React Component.

rc-virtual-list 
React Virtual List Component which worked with animation.

react-dom 
React package for working with the DOM.

react-fast-compare 
The fastest deep equal comparison for React.

react-i18next 
react-i18next implements internationalization for react using the i18next i18n ecosystem.

react-is 
React is a JavaScript library for building user interfaces.

Reactive Streams 
A Protocol for Asynchronous Non-Blocking Data Sequence

ReactJS 
React is a JavaScript library for building user interfaces.

Reactor Core 
Reactor Core is a non-blocking reactive foundation for the JVM.

react-popper 
Official React library to use Popper, the positioning library

react-scrollbar-size 
React hook to calculate the size of browser scrollbars.

readable-stream 
Node-core streams for userland. This package is a mirror of the streams implementations
in Node.js 18.19.0.

readdir-glob 
Recursive fs.readdir with streaming API and glob filtering.

Red Hat Linux 
Red Hat Enterprise Linux OpenStack Platform delivers an integrated foundation to create,
deploy, and scale a secure and reliable public or private OpenStack cloud. Red Hat
Enterprise Linux OpenStack Platform combines the world's leading enterprise Linux and
the fastest-growing cloud infrastructure platform to give you the agility to scale and
quickly meet customer demands without compromising on availability, security, or
performance.

ReflectASM 
ReflectASM is a very small Java library that provides high performance reflection by using
code generation. An access class is generated to set/get fields, call methods, or create a
new instance. The access class uses bytecode rather than Java's reflection, so it is much
faster. It can also access primitive fields via bytecode to avoid boxing.
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resolve-pathname 
Resolve URL pathnames using JavaScript

run-async 
Utility method to run function either synchronously or asynchronously using the common
`this.async()` style.

Rx .NET 
Reactive Extensions for .NET library used to validate entered values

Scala 
The Scala programming language fuses object-oriented and functional programming in a
statically typed programming language. It is aimed at the construction of components
and component systems.

Scallop 
Scallop is a command line parser.

scheduler 
React is a JavaScript library for building user interfaces.

scroll-into-view-if-needed 
Element.scrollIntoView ponyfills for things like "if-needed" and "smooth"

shallowequal 
Performs a shallow equality comparison between two values (i.e. value and other) to
determine if they are equivalent.

shebang-command 
Get the command from a shebang

SitemapGen4j 
SitemapGen4j is a library to generate XML sitemaps in Java.

SLF4J 
The Simple Logging Facade for Java (SLF4J) serves as a simple facade or abstraction for
various logging frameworks (e.g. java.util.logging, logback, log4j) allowing the end user to
plug in the desired logging framework at deployment time.

SnakeYAML 
YAML is a data serialization format designed for human readability and interaction with
scripting languages. SnakeYAML is a YAML parser and emitter for the Java programming
language.

SNMP4J 
SNMP4J is an enterprise class free open source and state-of-the-art SNMP implementation
for Java™ 2SE 1.4 or later. SNMP4J supports command generation (managers) as well as
command responding (agents). Its clean object oriented design is inspired by SNMP++,
which is a well-known SNMPv1/v2c/v3 API for C++.

source-map 
This is a library to generate and consume the source map format described here.

source-map-js 
Difference between original source-map: TL,DR: it's fork of original source-map@0.6, but
with perfomance optimizations.
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SpringFox 
Automated JSON API documentation for API's built with Spring.

Spring Framework 
The Spring Framework provides a comprehensive programming and configuration model
for modern Java-based enterprise applications - on any kind of deployment platform. A
key element of Spring is infrastructural support at the application level: Spring focuses on
the "plumbing" of enterprise applications so that teams can focus on application-level
business logic, without unnecessary ties to specific deployment environments.

StAX 
StAX is a standard XML processing API that allows you to stream XML data from and to
your application. This StAX implementation is the standard pull parser implementation for
JSR-173 specification.

streamx 
An iteration of the Node.js core streams with a series of improvements.

string_decoder 
Node-core v8.9.4 string_decoder for userland

strip-ansi 
Strip ANSI escape codes from a string

styled-components 
styled-components are visual primitives for the component age, enabling you to use ES6
and CSS to style your apps.

supports-color 
Detect whether a terminal supports color

SVG.NET 
Public fork of the C# SVG rendering library. This started out as a minor modification to
enable the writing of proper SVG strings. But now after almost two years we have so many
fixes and improvements that we decided to share our current codebase to the public in
order to improve it even further.

Swagger 
Swagger is a simple yet powerful representation of your RESTful API. With the largest
ecosystem of API tooling on the planet, thousands of developers are supporting Swagger
in almost every modern programming language and deployment environment. With a
Swagger-enabled API, you get interactive documentation, client SDK generation and
discoverability.

Swashbuckle.Core 
Seamlessly adds a Swagger to WebApi projects.

synchronous-promise 
A prototypical animal which looks like an A+ Promise but doesn't defer immediately, so
can run synchronously, for testing

system.configuration.configurationmanager 
Provides types that support using XML configuration files (app.config). This package
exists only to support migrating existing .NET Framework code that already uses System.
Configuration. When writing new code, use another configuration system instead, such
as Microsoft.Extensions.Configuration.
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system.diagnostics.diagnosticsource 
Provides Classes that allow you to decouple code logging rich (unserializable) diagnostics/
telemetry (e.g. framework) from code that consumes it (e.g. tools)

system.diagnostics.eventlog 
This package provides types that allow applications to interact with the Windows Event
Log service. When an error occurs in a Windows machine, the system administrator or
support representative must determine what caused the error, attempt to recover any lost
data, and prevent the error from recurring. It is helpful if applications, the operating
system, and other system services record important events, such as low-memory
conditions or excessive attempts to access a disk. The system administrator can then use
the Windows Event Log to help determine what conditions caused the error and identify
the context in which it occurred.

system.identitymodel.tokens.jwt 
Includes types that provide support for creating, serializing and validating JSON Web
Tokens. As of IdentityModel 7x, this is a legacy tool that should be replaced with Microsoft.
IdentityModel.JsonWebTokens.

system.memory 
Provides types for efficient representation and pooling of managed, stack, and native
memory segments and sequences of such segments, along with primitives to parse and
format UTF-8 encoded text stored in those memory segments.

system.runtime.compilerservices.unsafe 
Provides the System.Runtime.CompilerServices.Unsafe class, which provides generic,
low-level functionality for manipulating pointers.

system.security.accesscontrol 
Provides base classes that enable managing access and audit control lists on securable
objects.

system.security.permissions 
Provides types supporting Code Access Security (CAS).

system.security.principal.windows 
Provides classes for retrieving the current Windows user and for interacting with Windows
users and groups.

system.servicemodel.http 
Provides the types that permit SOAP messages to be exchanged using Http (example:
BasicHttpBinding).

system.servicemodel.primitives 
Provides the common types used by all of the WCF libraries.

system.text.encodings.web 
Provides types for encoding and escaping strings for use in JavaScript, HyperText Markup
Language (HTML), and uniform resource locators (URL).

system.text.json 
Provides high-performance and low-allocating types that serialize objects to JavaScript
Object Notation (JSON) text and deserialize JSON text to objects, with UTF-8 support
built-in. Also provides types to read and write JSON text encoded as UTF-8, and to create
an in-memory document object model (DOM), that is read-only, for random access of the
JSON elements within a structured view of the data.
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tar-stream 
tar-stream is a streaming tar parser and generator.

Thinktecture IdentityModel 
Helpers and client libraries for OpenID Connect, OAuth 2.0 and claims-based Identity.

Thinktecture IdentityServer 
Front-end Secure Token Service to serve SAML tokens.

throttle-debounce 
Throttle and debounce functions.

tmp 
Temporary file and directory creator for node.js

TwelveMonkeys Common 
TwelveMonkeys Common library contains common utility classes relating to languages,
I/O and images.

TwelveMonkeys ImageIO 
TwelveMonkeys ImageIO is a collection of plugins and extensions for Java's ImageIO.
These plugins extends the number of image file formats supported in Java, using the
javax.imageio.* package. The main purpose of this project is to provide support for
formats not covered by the JRE itself.

TXW2 
TXW is a library that allows you to write XML documents.

ua-parser 
A multi-language port of Browserscope's user agent parser.

universalify 
Make a callback- or promise-based function support both promises and callbacks.

use-sync-external-store 
React is a JavaScript library for building user interfaces.

util-deprecate 
The Node.js `util.deprecate()` function with browser support

valid-filename 
Check if a string is a valid filename

value-equal 
value-equal determines if two JavaScript values are equal using Object.prototype.valueOf.

warning 
A mirror of Facebook's Warning

wcwidth 
Port of C's wcwidth() and wcswidth()

WebGrease 
Web Grease is a suite of tools for optimizing javascript, css files and images.
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which 
Like which(1) unix command. Find the first instance of an executable in the PATH.

WiX 
The WiX toolset builds Windows installation packages from XML source code. The tool-set
integrates seamlessly into build processes.

Woodstox 
Woodstox is a high-performance validating namespace-aware StAX-compliant (JSR-173)
Open Source XML-processor written in Java.

wordwrap 
Wrap your words.

wrap-ansi 
Wordwrap a string with ANSI escape codes

wrappy 
Callback wrapping utility

Xalan-Java 
Xalan-Java is an XSLT processor for transforming XML documents into HTML, text, or
other XML document types. It implements XSL Transformations (XSLT) Version 1.0 and
XML Path Language (XPath) Version 1.0 and can be used from the command line, in an
applet or a servlet, or as a module in other program.

Xerces Java Parser 
The Xerces Java Parser 1.4.4 supports the XML 1.0 recommendation and contains
advanced parser functionality, such as support for the W3C's XML Schema
recommendation version 1.0, DOM Level 2 version 1.0, and SAX Version 2, in addition to
supporting the industry-standard DOM Level 1 and SAX version 1 APIs.

XML Pull Parsing 
An XML Pull Parsing API.

XStream 
XStream is a simple library to serialize objects to XML and back again.

XULRunner
XULRunner is a runtime environment developed by the Mozilla Foundation to provide a
common back-end for previewing.

zip-stream 
zip-stream is a streaming zip archive generator based on
the ZipArchiveOutputStream prototype found in the compress-commons project.
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